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INTRODUCTION TO Reckon Accounts

1
Installing Reckon Accounts 2

About Reckon Accounts 3

Learning about Reckon Accounts 4

Three steps to more Reckon Accounts help 6

Welcome to Reckon Accounts . This chapter provides a guide to getting started with Reckon 
Accounts, and explains how you can get the most from the documentation and support 
resources available.
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Installing Reckon Accounts

Begin with the Reckon Accounts  Installation and Upgrade Guide

Before you begin to work with Reckon Accounts , you’ll want to install your software or upgrade from an earlier 
version.

The Reckon Accounts  Installation and Upgrade Guide provides important information that you need to know 
BEFORE you install or upgrade your software. You’ll save time, find answers to your questions, and avoid potential 
problems if you follow this step-by-step guide.

The Reckon Accounts  Installation and Upgrade Guide is included with every purchase of Reckon Accounts . A copy 
of the guide is also included on your Reckon Accounts  CD. In addition, you’ll find the latest version of the Guide, 
including any last-minute changes or updates, on the Reckon web site (http://www.reckon.com).

Chapter 1
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About Reckon Accounts
Reckon Accounts is a software program that helps you manage your personal finances. It enables you to track many 
areas of your day-to-day finances, including pay slips, bills and general spending. You can categorise income and 
spending, and then generate reports that show where your money goes.

Reckon Accounts Personal Plus includes features for tracking tax and investments, and for developing long term 
financial plans.

Reckon Accounts Home & Business includes additional features designed to support a small cash-basis business. 
These features include recording customer payments, issuing funds and credits, recording mileage and more.

Features in Reckon Accounts are organised into centres, as shown in the table below. This table identifies which 
centres are included in each level of Reckon Accounts.

Centre Personal Plus Home & Business

Cash Flow a a

Property & Debt a a

Investing a a

Planning a a
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Centre Personal Plus Home & Business

Tax a a

Business a

Financial Overview a a

Each level helps you to sharpen the way you handle your finances, so that you can be sure your money is being 
saved or spent productively.

Learning about Reckon Accounts
The best place to start learning about Reckon Accounts is the user guide you are now reading. It is designed to give 
you an overview of how Reckon Accounts works and how you can make it work best for you.

Detailed information about individual features is available in the in-product help.

How this guide applies to Personal Plus and Home & Business

This user guide applies to Reckon Accounts Personal Plus, and Reckon Accounts Home & Business.

As a way of explaining features and concepts, we will use screenshots taken from Personal Plus or Home & Business. 
This means you may see screenshots of windows that are similar to those in your version, but with a different feature 
set. This won’t change the point of instruction, unless mentioned in the text.

Chapter 1



5

Conventions used in this guide

This guide follows the conventions shown in the table below.

To indicate... We use...

Reckon Accounts Personal Plus and Reckon Accounts Home & 
Business

Reckon Accounts

Reckon Accounts Personal Plus Personal Plus or Reckon Accounts Personal Plus

Reckon Accounts Home & Business Home & Business or Reckon Accounts Home & Business

A menu selection “Go to the Help menu and click Product Help.”

Note that we’ve added the word “menu” to indicate the main menu 
name, followed by one or more sub-menu items. The menu and sub-
menu item names are in bold type.

A button that you click The button name in bold type.

For example, “click Activate after entering...”

A key that you press on your computer keyboard to activate a 
function

The key name in bold type.

For example, “press F1 to access Reckon Accounts Help.”

The name of a window The window name in bold type.

For example, “The Preferences window opens.

Introduction to Reckon Accounts
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To indicate... We use...

The name of a drop-down list The drop-down list name in bold type.

For example, “Select Tasmania from the State drop-down list.”

Important information you should note

A hint, tip or technique you might find useful

Three steps to more Reckon Accounts help
If the answer you’re after is not in this guide, take the three-step approach to getting help with your Reckon 
Accounts software.
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Step 1 - Check the Reckon Accounts in-product Help

Your Reckon Accounts software comes with comprehensive in-product Help, extending the introductory material 
you’ll find in this user guide.

Use Reckon Accounts Help for in-depth overviews and procedures. To get task-specific help right where you’re 
working:

•	 Click the question mark or light bulb icons, or

•	 Press the F1 key

If available, Reckon Accounts displays specific help for the window you’re working in.

Light bulb icon Question mark icon

Introduction to Reckon Accounts
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If the first topic you reach isn’t what you want, click one of the tabs at the top left of the Help Topics window:

•	 Click the Contents tab, double-click one of the Help books on the left, then click a topic.
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▪▪ When you click the Contents tab, you see the current topic highlighted in the Help Table of Contents.

▪▪ The top level book icons link to Overview topics for feature areas. Top level books in Help usually correspond 
to Reckon Accounts menus (for example, features that you can access from Reckon Accounts’s Investing 
menu are discussed in the Investing section of Help).

▪▪ Second level books correspond to primary feature or task groups (for example, Using a cash flow register or 
Reconciling cash flow accounts). 

▪▪ Expand the How do I... book to view step-by-step procedures within each feature area.

•	 Click the Search tab, enter a phrase, and then click Ask.

To get the most accurate search results, type a 3- to 10-word question.

For example, instead of typing “category”, type “How do I create a category?” in the search field. Make your 
questions as specific as possible. They should be short and contain only one major topic. For example, “How do I 
add a chequing account?” will return better results than “How do I add a chequing and savings account?”

The Search field on the Reckon Accounts toolbar only searches Reckon Accounts transactions. It doesn’t search 
Reckon Accounts Help.

Working with the Help window

Introduction to Reckon Accounts
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•	 Within a topic,  and  shows and hides additional help content.

•	 Hide or show the Contents panel on the left by clicking the Hide (or Show) button at the top left corner of the 
window.

•	 Make the Contents panel bigger or smaller by clicking and dragging the divider bar.

•	 Make the Help window bigger or smaller by clicking and dragging its bottom left or right corner.

•	 Print a topic by selecting it and clicking Print this topic (at the bottom of the topic window). To print all the 
topics in a book, select the book in the Help Table of Contents and then click Print.

Step 2 - Check the Knowledge Browser

The Knowledge Browser in the Support area of the Reckon web site is an online technical support database that is 
available to all Reckon customers 24 hours a day, 7 days a week. Search for support articles which contain step-by-
step instructions to get you through any known Reckon Accounts product issues.

Alternatively, simply view the frequently asked questions on the Reckon support page. In many cases, you will find 
the solutions to your problem there.

Step 3 - Contact Reckon Technical Support

If you require technical support and prefer to speak to a Reckon representative, the Reckon Technical Support team 
is just a phone call away. Reckon’s trained technical support staff are available to help you during business hours, 
Monday through Friday.

For more information about technical support, including hours of operation and charges for your country, see 
“Contacting Reckon” on page 202 .

Chapter 1
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GETTING THE MOST FROM Reckon Accounts

2
Deciding how much detail you want to track 12

Opening Reckon Accounts for the first time 15

Learning Reckon Accounts essentials 17

Backing up your Reckon Accounts data file 24

Getting the most from this book 30

Each Reckon Accounts user has different financial goals, sources of income, and money 
management priorities. The beauty of Reckon Accounts is that it is powerful and flexible 
enough to help most people manage their finances better.  
Use this chapter to learn how Reckon Accounts works and to decide how much detail you want 
from Reckon Accounts.
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Deciding how much detail you want to track
Like others using this program, you will have unique requirements for the financial areas you wish to track. On 
a personal level, you may only want to record general cash flow (income and expenses) but not investments. Or 
perhaps you only need to track investment information, without the cash flow. If running Home & Business you may 
wish to track personal and business finances, but not investments. Your personal needs will determine the Reckon 
Accounts features that you will use.

You then need to decide how much detail to track within each feature you decide to use. Do you wish to record each 
time you spent cash in a month or just the total of cash spent within certain categories for a month? It’s something 
you need to decide up front before regularly using the program. It’s important to be consistent with the level of 
detail you record in the program, as this information will affect reports and planning.

Remember, the more detail you track, the better picture Reckon Accounts can give you of your financial situation.

Let’s take a quick look at some of the financial areas you can track:

•	 Cash flow. This covers basic banking where you receive money (mostly through a pay slip or investment 
dividend) and you spend money. It allows you to set up accounts that match your real-life accounts and record 
detailed transactions. You can even download bank statements to make sure your records are current. The 
Cash flow area also allows you to record bills and schedule repeating transactions like rent, gym membership, 
recurring insurance and utility payments.

•	 Investing. This covers all your investments - individual shares, managed funds and retirement funds. It allows 
you to set up an account for the shares you own and download the latest share prices. It also allows you to set up 
accounts to keep an eye on your managed funds or retirement funds. 

•	 Property and debt. This enables you to record information about the property you own. Set up asset accounts 
to cover the cost of a house, car or business equipment. Set up liability accounts to track the state of your loans. 
Take advantage of the brand new Reckon Home Inventory Manager to keep an organised record of all your 
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household items, receipts, and photos to help insurance claims go smoothly. It simplifies estate planning by 
recording items, and noting the beneficiary associated with each item.

•	 Business. This covers all areas of the cash-basis accounting system you use for your business. It includes 
accounts to record your income and expenses, and the tools to set up customer and supplier records. As a bonus, 
Home & Business allows you to create an estimate or invoice even though the program has been developed as a 
cash-basis accounting system. (Available in Home & Business only.) 

The way you track these details affects the following Reckon Accounts features:

•	 Planning. Reckon Accounts can use current data in your system to make future projections about your financial 
situation for home, business or both (depending on the level you are running). The more detail Reckon Accounts 
has to work from, the better forecast it can provide. This area includes a Debt Reduction Calculator. You can 
also use additional financial calculators to create scenarios for superannuation, loans, savings, refinancing or 
University savings for your kids. 

•	 Reports. You can get reports on your day-to-day spending, investment transactions, business profit and loss and 
much more. Again, the more information you track on a day-to-day basis, the better the detail in your reports 
and subsequently the better picture you’ll get of your finances.

•	 Tax records. The Tax Planner can tell you how much tax you owe for general income tax or you can get Home & 
Business to generate the actual figures to include in your next BAS. Home & Business generates this information 
from the data you enter into the program each day. (The BAS report is available in Home & Business only.)

The following table shows you where to find specific information about details you may wish to track.
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If you want to... Refer to...

Work out how much detail to track, open the program, learn about the basic elements of Reckon Accounts, 
and learn to back up your Reckon Accounts file.

Chapter 2

Decide whether to include personal and business information in the same Reckon Accounts file, set up 
personal accounts and categories, set up business accounts, categories, tags, invoice items, customers and 
suppliers.

Chapter 3

Carry out regular record keeping for your personal finances such as updating accounts, reconciling 
accounts with your online accounts, and assigning categories to transactions.

Chapter 4

Set up accounts to track your investments, update your investment accounts, buy shares as an enterprise 
and track you portfolio’s performance.

Chapter 5

Set up Reckon Accounts to track your work income and tax deductible income so you’re ready at tax time 
to maximise your tax benefits quickly.

Chapter 6

Track ABN withholding amounts, track GST received and paid, create estimates and invoices with GST 
amounts.

Chapter 7

Create estimates or invoices, record payments from customers or issue refunds, pay suppliers or receive 
refunds and track mileage.

Chapter 8

Determine the health of your personal and business finances, including tracking home value and the 
associated loan, vehicle value and the associated loan, analysing personal net worth, understanding 
business cash flow and your BAS liabilities

Chapter 9

Use existing data and different scenarios to plan your personal and business finances into the future. Chapter 10
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Opening Reckon Accounts for the first time
To use the features in Reckon Accounts you need to have a Reckon Accounts file open. This is a file that stores 
information about the features you use and the day-to-day data you will later record (see “Reckon Accounts data file” 
on page 17 for more information). If you don’t already have a personalised Reckon Accounts data file, you will have 
several options the first time you open Reckon Accounts.

One option is to open the sample data file, which you can use to see how a typical user might set up the program. 
Another option is to use the Reckon Accounts Express Setup to help you set up your own data file.

When you go to the File menu and click New, the Reckon Accounts Express Setup wizard opens. The Express 
Setup wizard will ask you a series of questions about yourself so that Reckon Accounts can create a data file that 
adequately supports your situation. You can exit this wizard at any time during setup, or make changes later to the 
details you enter now. The purpose of the wizard is to make setting up your data file fast and easy for you.

You’ll find the Reckon Accounts Express Setup an easy process. There is plenty of in-product Help to guide you 
comfortably through the setup process.
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These are two sample 
pages you’ll see as 
part of the Reckon 
Accounts Express 
Setup.

You can follow 
your progress 
through the 
Express Setup 
from the menu 
here.
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Learning Reckon Accounts essentials
Take a few minutes right now to familiarise yourself with some essential Reckon Accounts terms and concepts. You’ll 
see these terms throughout this guide and while you’re using Reckon Accounts.

Reckon Accounts data file

Reckon Accounts saves your financial information in a data file on your computer. As with other types of files, such 
as word-processing or spreadsheet files, you store this file in a folder on your hard disk. Unlike most other programs, 
however, Reckon Accounts immediately saves your information as you work; you don’t need to save the file 
manually. As with all important data, you should still back up your Reckon Accounts file frequently. You’ll learn how 
to back up your file later in this chapter.

Accounts

Within a single Reckon Accounts file, you can add many accounts to organise your financial information. You can 
add several accounts (such as chequing, savings, brokerage, and so on), or you can start with a single account (such 
as a chequing account). You can also add Accounts to track other aspects of your financial life, such as a home 
mortgage or a vehicle loan. You can even set up an account to track superannuation, a brokerage investment 
account or a managed fund.

You should set up all your Accounts within a single Reckon Accounts file. That way, you can use Reckon Accounts to 
create reports that reflect your complete financial picture.

Getting the most from Reckon Accounts
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Initially, you may want to add only a chequing or investment account. Later, you can add additional accounts to 
track more of your financial activities. The types of accounts you can add are shown in the following illustration 
(from Home & Business).

Each account contains a register or Transaction List to store account details.
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Centres

When you add a new account, Reckon Accounts groups it with all other accounts of the same type in a relevant 
account centre. You can view your data with pertinent tools and reports from these account centres. One of these 
account centres, the Financial Overview Centre, displays every group of accounts together.

Let’s take a look at the account centres for cash flow, investing, property and debt, planning, tax and financial 
overview.

Cash Flow Centre

You’ll find accounts for chequing, savings, credits cards, and cash in the Cash Flow Centre. Use these accounts to 
better understand your day-to-day income and expenses. These accounts are discussed in more detail in Chapter 4, 
“Performing everyday personal tasks”.

Investing Centre

You’ll find accounts for investments in the Investing Centre. Use these accounts to track the ongoing performance 
of your stocks and bonds, retirement funds, and other types of investments. These accounts are discussed in more 
detail in Chapter 5, “Managing your investments”.

Property & Debt Centre

You’ll find accounts for assets (what you own) and liabilities (what you owe) in the Property & Debt Centre. Use these 
accounts to track financial activities that affect your net worth. For example, using a House account lets you track 
the equity you’re building and the loan you’re paying down as you make your mortgage payments. These accounts 
are discussed in more detail in Chapter 9, “Determining your net worth”.
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Planning Centre

Use the Planning Centre to make realistic financial plans and see how they are progressing. From this centre, you’ll 
see overviews of your plans for savings, expenses and budgeting. You’ll also have access to budget tools and the 
financial calculators. The Planning Centre is discussed in more detail in Chapter 9, “Determining your net worth”.

Tax Centre

You’ll find information about projected tax and important tax dates in the Tax Centre. You’ll also get access to 
features like the Tax Planner, Capital Gains Estimator and Paycheque Setup wizard. You can also set up your own tax 
alerts from this centre. The Tax Centre is discussed in more detail in Chapter 7, “Planning for business tax time”.

Business Centre (Home & Business only)

You’ll find all your business accounts displayed on the My Data tab. This includes any accounts you have set up 
from the Business menu. You’ll also see the *Tax Control* Account, which Home & Business created to track your 
tax liability automatically as soon as you use GST in the transaction of an account. You can use this to monitor the 
key accounts that show how your business is going. The Business Centre is discussed in more detail in Chapter 8, 
“Performing everyday business tasks”.

Financial Overview Centre

You’ll find all your accounts displayed together on the Net Worth page of the Financial Overview Centre. Use this 
page to monitor the change in value of your finances over time, and to see the current allocation of your finances by 
account type. Net worth is discussed in more detail in Chapter 9, “Determine your net worth”.

Registers and the Transaction List

Reckon Accounts displays transactions in the way that makes the most sense for each type of account.
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Registers

Each non-investment account in Reckon Accounts has a register. The register looks like a paper cheque book register, 
where you record cheques you’ve written and deposits you’ve made. The Reckon Accounts register even calculates 
your current balance for you.

Transaction List

Each investment account in Reckon Accounts has a Transaction List. The Transaction List resembles a brokerage 
statement and is specifically designed to manage both the investing transactions and cash transactions for an 
account in the same place.
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Transactions

You enter individual transactions within the register of each Account that corresponds to your real-world income 
and expenses. For example, you could enter cheque number 313 for $39.96 to McCarthy Fruit & Veg as a payment 
transaction in your chequing account. Similarly, you would enter your pay slip as a deposit transaction in the same 
account.

Categories

To get the most out of Reckon Accounts, you should assign one or more categories to each transaction. Categories 
track the source of a deposit (such as salary), the reason for an expenditure (such as a utilities payment), or the name 
of the account to which you’re transferring funds (such as savings).
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If you’re interested in managing your money in any detail (and getting the most from Reckon Accounts reports), you 
should use categories. You’ll learn more in Chapter 3.

Tags

Tags make it possible for you to track a group of similar items with a single category, which makes it unnecessary 
to clutter up your Category List with a lot of additional categories. For example, say you want to track how much 
you spend each year for vehicle repairs. If you have a car and a truck, you can add a tag named “car” and another 
one named “truck” and use them both with the Auto:Service category. This keeps your Category List a lot more 
manageable than it would be if you added a service category for the truck and another one for the car.
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Enter tags in the Tag field.

Click the arrow to the right of 
the Tag field to display the list 
of existing tags.

For more information about tags, go to the Help menu and click Product Help. Click the Search tab, enter using 
tags, and then click Ask.

Backing up your Reckon Accounts data file
Reckon Accounts saves your data file on your hard disk each time you enter a new transaction. However, you should 
back up your Reckon Accounts data regularly so you always have a copy in case of a hardware failure or computer 
virus.

When you manually back up your Reckon Accounts data file with the following procedure, if you have attached 

Chapter 2
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images such as receipts or statements to your Reckon Accounts transactions or accounts, Reckon Accounts backs up 
these attachments with your data file only if there is enough room for all of them. If there isn’t enough room for all 
of your attachments, none of them are included in the backup.

You can back up your Reckon Accounts data file to removable drives, CDs, DVDs, USB memory stick, Flash Drive and 
External Hard Drive. 

Another way to safeguard your valuable Reckon Accounts data is to back it up every day to a remote location with 
the Reckon Backup service (service fees apply; service subject to change).

Setting Backup Preferences

Before backing up your Reckon Accounts data file, make sure you have set your Backup preferences.

To set backup preferences:

1.	 Go to the Edit menu, click Preferences, and then click Program.

The Reckon Accounts Preferences window opens.

2.	 In the Select preference type area on the left side of the window, click Backup.

The Backup preferences dialog is displayed.

Getting the most from Reckon Accounts
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Backup preferences you can set include:

•	 Remind after running Reckon Accounts (0 - 99) times 

In other words, instruct Reckon Accounts to pop up a message reminding you to back up your Reckon Accounts 
data file after running Reckon Accounts the number of times you indicate. 

The default number of times is 3. If you do not wish to be reminded to back up your file, enter “0”.

•	 Maximum number of backup copies: 1 - 9

In other words, after creating and storing this number of copies (1 - 9) , do not create and store an additional file; 
instead, overwrite the oldest existing backup file. Setting this preference to a lower number can be particularly 

Chapter 2
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useful if you need to conserve disk space and your Reckon Accounts data file is very large.

The default maximum number of backup copies is 5.

•	 Warn before overwriting old files.

In other words, instruct Reckon Accounts to pop up a message warning that an old backup copy will be 
overwritten. 

This preference is selected by default. If you do not wish to see this warning, click to deselect.

•	 Select the disk drive and path to the backup folder

Enter or browse to select a default location where you prefer your backup files to be stored.

The default location is C:\.

•	 Add the date to the file name (e.g., QDATA_20160804). 

This will help you identify which file is the latest backup.

Adding the date to the file name is good practice, as it can help you avoid overwriting valuable files and allows 
you to quickly identify when backup files were created. If you use a different file naming scheme, you may wish 
to click to deselect this preference. However, Reckon recommends maintaining the default setting.

This preference is selected by default.

When you have set your backup preferences as you want them, click OK.

Getting the most from Reckon Accounts
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To back up your Reckon Accounts data file:

1.	 If it isn’t already open, open the Reckon Accounts data file you want to back up.

2.	 Go to the File menu and click Backup

The Backup window opens.

3.	 Select the appropriate option:

▪▪ (By default) Check Backup data to compressed archive (.rkn) file if you want to create a compressed 
backup file.

▪▪ Click Local Backup to back up to an external source (such as a removable drive, CD, DVD, and so on). Enter or 
browse to the backup location if necessary, and then click OK. 

Reckon Accounts backs up the file, then displays a message telling you that the backup was successful.

▪▪ If you have already subscribed to Reckon Backup and installed the Reckon Backup desktop application, click 
Reckon Backup, and then click OK. After you log in with your user name and password, Reckon Backup 
encrypts your data and sends it to be safely stored.

If you haven’t yet subscribed to Reckon Backup, visit the Reckon website for more information and to 
subscribe (http://www.reckon.com).

Chapter 2



29

To restore your Reckon Accounts data file:

1.	 Go to the File menu and select Restore Backup File then click Restore Backup...

The Restore window opens.

2.	 Select the appropriate option:

▪▪ Click Local Backup to restore from an external source (such as a removable drive, CD, DVD, and so on). Enter 
or browse to the backup location if necessary, and then click OK. 

Select the backup file (.RKN or.QDF) to restore, and then click OK.

Getting the most from Reckon Accounts
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Select the path where you want to restore the file to, if different to the default location, and then click OK.

Reckon Accounts restores the file, then displays a message telling you that the restoration was successful.

▪▪ If you have already subscribed to Reckon Backup and installed the Reckon Backup desktop application, click 
Reckon Backup, and then click OK. After you log in with your user name and password, Reckon Backup 
encrypts your data and sends it to be safely restored.

If you haven’t yet subscribed to Reckon Backup, visit the Reckon website for more information and to 
subscribe (http://www.reckon.com).

3.	 To open the restored file, click the File menu then click Open. The window file explorer will open, open the file 
that you just restored or navigate to where the file has been restored to.

Getting the most from this book
As you read this book, use your own financial data to learn basic but powerful Reckon Accounts features. After you 
complete the tasks in a chapter, you’ll be able to use Reckon Accounts immediately to help achieve your personal 
financial goals.

Each chapter builds on the chapters that come before. Before you begin working through a chapter, make sure 
you’ve performed all the tasks and gathered all the recommended materials listed in “Before you start” and “What 
you’ll need” at the beginning of the chapter.
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GETTING STARTED WITH Reckon Accounts

3
Getting started with the personal side of Reckon Accounts 32

Setting up to support your business finance tracking 47

Each Reckon Accounts user has different financial goals, sources of income, and money 
management priorities. The beauty of Reckon Accounts is that it is powerful and flexible 
enough to help most people manage their finances better.

In this chapter, we’ll look at setting up a way for you to track your finances. The scope of this, 
for you, will depend on the level of Reckon Accounts you are using:  Personal Plus or Home & 
Business.

This chapter begins with information that applies to your personal finances, then covers your 
business finances if you are running Home & Business.
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Before you start

Think about the accounts you want to track in Reckon Accounts. This chapter begins with a discussion 
of chequing and savings accounts, as well as cash and credit cards. Then, the focus turns to business 
accounts and other business features for the Home & Business user.

What you’ll need

In order to set up your accounts, you’ll need your most recent statements for the chequing, savings, 
and credit card accounts you plan to track with Reckon Accounts.

Getting started with the personal side of Reckon Accounts
The first area in Reckon Accounts to get familiar with is how to track personal finances.

Learning how categories help manage your finances

Before you begin managing your income and expenses in Reckon Accounts, you should understand how Reckon 
Accounts tracks financial information. As described in “Opening Reckon Accounts for the first time” on page 15, the 
key to money management in Reckon Accounts is categories.

Categories are labels that track how much you’re spending on particular types of items, such as rent, groceries, or 
dining. For example, you might use the “Clothing” category with the following transactions:

•	 a cheque for $229.13 for a new jacket
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•	 a credit card purchase of $100.00 for some mail-order boots

•	 a few cash purchases for new school clothes for the kids, totalling $210.00

Because these transactions use the same category, it’s easy to produce a mini-report for the Clothing category like 
the one shown below. And if you want to see how much you’ve spent on clothing in greater detail, just click the 
Show Report button at the bottom of the mini-report.

Click the arrow to 
display the transactions 
for another time period

Click Show Report 
at the bottom of the 
mini-report to display an 
expanded report for the 
category.

When you assign 
categories to your 
transactions, this report 
can show where your 
money goes.

Click the mini-report 
button next to the 
Category field to run this 
report
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Make it a habit to use categories with all your transactions. The first time you enter a transaction and payee, you 
may need to change or assign a category. But after you do, Reckon Accounts remembers this information and 
automatically fills it in for you the next time you enter a transaction for that payee. And if you want to change the 
category for some reason, it’s easy to do. For more information, refer to Chapter 4, “Performing everyday personal 
tasks”.

Deciding which accounts to track

If you want to track your overall income, spending, and saving habits, you need to add more than one Account. Use 
the following guidelines to help you decide which cash flow accounts to add. (Remember, you should add all these 
accounts in a single Reckon Accounts data file.) 

•	 Chequing

This is the most commonly used account. Start with the account that you deposit your pay cheque into and from 
which you pay most of your bills and make tax-related expenditures (such as charitable donations and mortgage 
interest).

•	 Savings

Use this account type for standard savings accounts, such as those available at most banks or credit unions.

•	 Credit card

Many people track one or more credit cards in Reckon Accounts. Start with the one you use most often. 
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Adding accounts to Reckon Accounts to track your credit cards enables you to download and 
categorise your transactions, which can give you great insight into how you’re spending your 
money.

If you aren’t interested in tracking this level of detail and simply want to track how much you pay 
toward your credit cards each month, you can track your credit cards as bills instead.

How you’ll review the information for each option is discussed in more detail in “Reviewing your 
cash flow activity” on page 37. For more information about deciding how to track credit cards 
in Reckon Accounts, go to the Help menu and click Product Help. Click the Search tab, enter 
decide about credit cards, and then click Ask.

•	 Cash

If you want to know where all your money goes, including the cash you carry with you, you can add a separate 
account to track cash. 

A simpler way is just to create a category called “Cash,” and then assign it to ATM transactions and other cash 
withdrawals in your chequing account register. If you do set up a separate account for cash transactions, save 
yourself some time and track only to the nearest dollar.

Adding your cash flow accounts

To add a Cash Flow account:

1.	 Go to the Cash Flow menu and click Go to Cash Flow Centre.

2.	 In the upper right corner, click the My Data tab.

Getting started with Reckon Accounts
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3.	 In the Spending & Savings Accounts snapshot, click Add Account.

The Account Setup window opens.

4.	 In the Choose the type of banking account to create area, select Chequing, then click Next.

5.	 In the What is the financial institution for this account? area, type the name of your financial institution.

If your financial institution is in the list that Reckon Accounts displays, select it.

If you entered a name for a financial institution not on the list, Reckon Accounts will display an additional 
dialog box when you click Next. It indicates that your name does not match any of the names in the list. In this 
case, click the None of these. Use the following name: radio button. Then make sure that your chosen name 
populates the associated field.

6.	 Click Next.
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7.	 In the Name this account field, type the name by which you want to refer to this account in Reckon Accounts. 
Then click Next.

8.	 If you are using Home & Business, select whether you want to track tax in this account. Then click Next.

If you choose to track tax in this account, the account will use your home currency by default.

9.	 If you did not choose to track tax in this account during the previous step, choose the currency you wish to use 
for this account from the Currency drop-down list. Then click Next.

10.	Enter the ending date from your bank statement in the Statement Date field.

11.	Enter the balance from your bank statement in the Ending Balance field.

12.	Click Done.

Reckon Accounts displays the register for the account so you can enter your transactions. See “Updating your 
cash flow accounts” on page 62 to learn how.

Reviewing your cash flow activity

Reckon Accounts makes it easy to track the activity of your cash flow in a way that emphasises what’s important to 
you. The Cash Flow Centre provides a number of ways to view your income and expenses along with many useful 
tools to help you analyse and manage them. 

You’ll find a different focus on each page of the Cash Flow Centre. Go to the Cash Flow menu click Go to Cash Flow 
Centre, and then click the button that has the information you want.
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Cash Flow helps you track what 
you actually spent (and made) for 
the month.

My Savings Plan helps plan what 
you want to save and spend for the 
current month

My Data focuses on your 
current cash flow accounts 
and balances.

Analysis & Reports provides an 
in-depth analysis of your income 
and expenses over time.

Tracking your monthly income and expenses

The Cash Flow page includes the In/Out/What’s Left snapshot as well as reports that provide insight into the data 
consolidated in the snapshot.

The In/Out/What’s Left snapshot displays your income and expenses for the current month, but you can see 
projections of future months or information for past months by clicking the arrows on either side of the month 
above the snapshot. You can also forecast your cash flow balances in the future months by clicking the Cash Flow 
Forecast button or the Quarterly Cash flow tab.



39Getting started with Reckon Accounts

Click the Add Transaction button to add more 
income sources or expenses.

Click the arrows to see information 
for another month.

Click the button/tab to forecast 
your cash flow balances in the 
future.

The values and estimates in the In/Out/What’s Left snapshot consist of the bills, deposits, and transfers you schedule 
and record each month. Scheduled bills and deposits are reminders of expected income and expenses that you 
have told Reckon Accounts about. For example, if you used Express Setup to set up your current Reckon Accounts 
data file, then the In area of the snapshot displays the pay cheques and other deposits that you told Reckon 
Accounts about, while the Out area of the snapshot displays the bills and credit card payments that you told Reckon 
Accounts about. When you enter a transaction into Reckon Accounts, it becomes a recorded bill or deposit.

Keeping your monthly income and expense data current

The more complete your income and expense information is in Reckon Accounts, the more accurate and helpful the 
In/Out/What’s Left snapshot will be in helping you to project your cash flow from month to month.
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Adding a new income transaction

When you have a new source of income to track in Reckon Accounts, it’s simple to add a new scheduled transaction 
to track the deposit.

In this section, you’ll learn how to enter a scheduled transaction for a basic deposit. You’ll learn the specifics for 
adding scheduled transactions for pay cheques in Chapter 6, “Planning for personal tax time”.

1.	 Go to the Cash Flow menu and click Go to Cash Flow Centre.

2.	 In the upper-right corner, click Cash Flow.

3.	 In the In/Out/What’s Left snapshot, in the In area, click Add Transaction.

The Add Transaction window opens.

4.	 Select Yes I would like to schedule this transaction.

5.	 In the Payee Information section, click the Payee drop-down arrow to select the payee from whom you receive 
the payment. If the payee you want is not listed, enter the payee name in the Payee field. 

6.	 Click the Category drop-down arrow to select a category for this transaction.

7.	 In the Tag field, enter the appropriate tag. (Optional)

8.	 In the Memo field, enter a memo. (Optional)

9.	 In the Payment Information section, click the Account to use drop-down arrow and select the account into 
which this payment will be deposited.

10.	Click the Method drop-down arrow and select Deposit.

11.	In the Amount field, enter the amount of the deposit.
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12.	In the Scheduling area, enter the first day this deposit should occur, whether you want to be reminded to enter 
the deposit into Reckon Accounts yourself or have Reckon Accounts enter it for you automatically (without 
prompting), the frequency of the deposit, and if and when the scheduled deposit should end. Click the Help 
icon for more information.

13.	Click OK.

Reckon Accounts adds the deposit amount to the Expected Income section of the In area of the In/Out/What’s 
Left snapshot. Click Expected Income to see all the income Reckon Accounts is tracking for a particular month.

Adding a new payment transaction

When you have a new bill to track in Reckon Accounts, such as the payment amount for a new credit card, it’s just as 
easy to add a new scheduled transaction to track the payment.

In this section, you’ll learn how to enter a scheduled transaction for a basic payment.

1.	 Go to the Cash Flow menu and click Go to Cash Flow Centre.

2.	 In the upper-right corner, click Cash Flow.

3.	 In the In/Out/What’s Left snapshot, in the Out area, click Add Transaction.

4.	 Click Yes. I would like to schedule this transaction.

5.	 In the Payee list, enter who you make the payment to.

6.	 In the Category field, select Credit Card Payment.

If you added a credit card payment to Reckon Accounts during Express Setup, Reckon Accounts will have added 
the Credit Card Payment category for you. If this category isn’t already in the Category List, Reckon Accounts will 
prompt you to add it at the end of this procedure.

Getting started with Reckon Accounts
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7.	 In the Tag list, enter the appropriate tag. (Optional)

8.	 In the Account to use field, select the account that this payment will be made from.

9.	 In the Method field, select Payment.

10.	In the Amount field, enter the amount you expect to pay toward this credit card each month. You can change 
this amount when you enter the transaction in Reckon Accounts, so just enter an estimate if you’re not sure.

11.	In the Scheduling area of the dialog, enter the day this payment should start, whether you want to be reminded 
to enter the payment into Reckon Accounts yourself or have Reckon Accounts enter it for you without 
prompting, the frequency of the payment, and if and when the payment should end.

12.	Click OK. 

Reckon Accounts adds the deposit amount to the Bills section of the Out area of the In/Out/What’s Left snapshot. 
Click Bills and Other Expenses to see all the expenses Reckon Accounts is tracking for the month in question.

13.	If Reckon Accounts prompts you to add a Credit Card Payment category, click Yes, select Expense in the Type 
area, and then click OK.

That’s it! You’ve added new scheduled transactions for both income and expenses.

Planning your monthly spending

The Savings Plan helps you set, track, and control your personal spending so you’ll have more money available to 
save. This differs from the In/Out/What’s Left snapshot, which helps you track your actual spending (and inflow) for 
the current month.

You can use the Savings Plan to manage regular monthly expenses, such as your mortgage and groceries, as well as 
expenses that occur less frequently, such as car insurance and property taxes.
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Reckon Accounts uses your existing data (such as your pay cheque, scheduled bills, and categorised transactions) to 
prefill the graph and worksheet with default values. However, you can customise the Savings Plan to track the things 
that are most important to you.

1.	 Go to the Cash Flow menu and click Go to Cash Flow Centre.

2.	 In the upper-right corner, click My Savings Plan.

Reckon Accounts displays the Savings Plan page, which contains the status graph at the top and the worksheet 
beneath it.

Reckon Accounts 
uses your existing 
data to prefill 
the graph and 
worksheet.

You can customise 
the Savings Plan 
to track the things 
that are most 
important to you.

3.	 To adjust your expected income for the month, click Edit, enter the new amount, and then click OK.

Reckon Accounts starts with the value of your regular pay cheque, but you should adjust this amount to account 
for bonuses, transfers from savings, months where you expect to place a lot of expenses on credit cards, and 
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other fluctuations in the total monthly resources available to the plan.

4.	 Use the Savings Plan worksheet (below the horizontal bar status graph) to set up your plan. As you enter or 
change amounts, click Apply (to the right of the field you’re editing) to save your changes. For more information 
about each of the sections in the worksheet, click the Help icon to the right of the section title.

Getting answers with Reckon Accounts reports and graphs

Reckon Accounts reports and graphs can show you how you’re spending your money for a wide number of time 
periods. When you assign categories to your transactions, Reckon Accounts can show your spending based on what 
you spend your money on. When you assign payees to your transactions, Reckon Accounts can show your spending 
based on where you spend your money.

On page 33, you learned how to create a mini-report for a single category from the register . You can also create 
mini-reports for single payees from the register. However, when you want to look at data for several categories or 
payees at one time, use the Reports & Graphs Centre.

1.	 Go to the Reports menu and click Reports & Graphs Centre.

The Reports & Graphs window opens.

2.	 In the Reckon Accounts Standard Reports list on the left, click Spending.

Reckon Accounts displays the list of available spending reports and, when applicable, corresponding graphs.
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Click Spending 
to display a list 
of available 
spending reports 
and graphs, and 
then click the one 
you want.

When you’re 
ready to run 
the report, click 
Show Report or 
Show Graph

Reckon 
Accounts stores 
the reports you 
save in the My 
Saved Reports 
list.

You can create 
folders to 
organise your 
saved reports.
Click Manage 
Saved Reports to 
get started.

3.	 Click Spending by Category to see what you’re spending your money on, or click Spending by Payee to see 
where you’re spending your money.

4.	 Select the date or dates you want the report or graph to include. (Optional)

5.	 Click Show Report or Show Graph.

Reckon Accounts displays a report or graph that reflects your expenses, based on the categories or payees you 
assigned when you entered transactions.
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Click the PLUS 
(+) or MINUS 
sign (-) to the left 
of a category to 
display or hide 
the corresponding 
subcategories.

Some reports 
include a trend 
graph icon to the 
left of the category. 
Click the icon 
to display your 
average monthly 
spending for an 
expense category or 
payee over the past 
year.

If you move 
your pointer 
over report totals 
with details 
available, the 
pointer turns into 
a magnifying 
glass. Double-
click to zoom in 
on the details.

6.	 To print the report to paper or to a PDF, click the Print icon. To export the report to another program, such as 
Excel or to the Clipboard, click Export Data. Click the Help icon if you need more information. (Optional)

7.	 Click Save Report, type a unique name for the report, select or create the folder or area where you want to save 
the report, and click OK. (Optional)

The next time you want to open the saved report, you can do so from the My Saved Reports list on the right 
side of the Reports & Graphs window. To add a link for the report to the Reckon Accounts toolbar so that you 
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can access the report again with a single click, right-click the Customise toolbar.

Spend some time experimenting with reports to get an idea of the different kinds of financial information that 
Reckon Accounts can provide. Try customising a report to change how it is laid out or the scope of information it 
includes (saved reports retain their customised settings). Notice that when you run another report, the original 
report is minimised in the taskbar at the bottom of the screen so you can easily return to it at any time during 
your Reckon Accounts session.

Setting up to support your business finance tracking

Business features are available in Home & Business only. 

This section does not apply to Personal Plus.

Setting up business accounts

Accounts and categories in Reckon Accounts are equivalent to the traditional chart of accounts used for tracking 
income, expenses, assets, and liabilities. You should set up a account for each real-world account that your business 
uses, such as a business chequing or business credit card account.

You can create the following type of business accounts from the Business Centre:

•	 Business spending and savings accounts. This includes chequing, savings, credit card and cash accounts. You 
should create accounts in Reckon Accounts to mirror your real world business accounts. Generally you need 
to choose one of these to act as the account for which you receive money from your customers for goods and 
services along with goods and services you purchase from suppliers. If tracking GST, it’s important to enable the 
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account for tax tracking as part of the setup.

•	 Business Property & Debt Accounts. This includes house or vehicle accounts (with or without a loan), asset (for 
business items) or liability accounts (for business loans).

•	 *Tax Control*. This covers your tax liability but is an account you don’t set up. Home & Business does this 
automatically when you enable an account for tax tracking. This account shows increases and decreases to your 
tax liability. Every time you record a deposit with tax in a spending or savings account enabled for tax, your tax 
liability will increase. Each time you record payment, your tax liability will decrease by the amount set by the tax 
code applying to the transaction.

Deciding whether to include business and personal accounts in one Reckon Accounts file

Should you include business and personal accounts in the same Reckon Accounts file?

It’s prudent to clearly separate business from personal finances so that you can better report your tax when it comes 
to tax time. Clearer records will make it easier if there’s a time when the tax office wishes to audit you.

There are three ways that you can keep business and personal records separate in Reckon Accounts:

•	 Add personal and business accounts in one Reckon Accounts file and track them both in the same file. Be sure 
that your business chequing, credit card and other accounts are used solely for your business. This lets you track 
all your finances in one place and do tax planning for both employment and self employment income. Use the 
preset business categories to track business-related transactions.

•	 Set up separate Reckon Accounts files for your home and for your business. The drawback is that you can’t see 
a combined picture of your home and business finances. Only a picture of your home finances and a separate 
picture of your business finances.

•	 Mix business with personal data in the same chequing account. Use both categories and classes to distinguish 
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between personal and business transactions. (This is not recommended, for tax reasons.)

Working with business categories

Earlier we covered how to use categories in the section “Learning how categories help manage your finances” on 
page 32. The examples fitted a personal finance context, but the same principles apply to business.

For example, you might wish to track business expenses like bad debts, cost of goods sold or insurance payments. 
When entering transactions for any of these, you can apply the appropriate category so that you can see a better 
picture of where your expenses are going through reports when reviewing what you spend.

You can set up unique business categories to suit your own requirements in the same way that you would create a 
normal category.

Setting up business tags

A business tag is a specialised tag that Reckon Accounts uses to group the transactions for a business.

After you add the business tag and apply the business tag to the appropriate transactions, Reckon Accounts displays 
the data for your business in a number of ways.

Adding a business tag to Reckon Accounts

When you add a business to Reckon Accounts, you tell Reckon Accounts the name of your business and the tag you 
want to use for the transactions for that business.

Using a business tag with a transaction

When you enter a transaction in Reckon Accounts, you have the option to include a tag. When one of the tags you 
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include is a business tag, Reckon Accounts can associate the transaction with the appropriate business.

•	 When you have only one business, you don’t need to include a business tag with every transaction. 

When you add a business to Reckon Accounts, you have the option to select a check box called Business 
transactions without a tag belong to this business. When you do, any business transaction without a tag or 
with a tag that doesn’t belong to a business will automatically belong to the business that you’ve selected this 
check box for.

•	 When you have a transaction that applies to more than one business, you should split the transaction and assign 
the correct business tag in the Split Transaction dialog.

If you have more than one business, there are times when you might make a single purchase that you want the 
businesses to share, such as a box of copy paper. In this case, you should enter the transaction with the same 
payee and category, but you should split the transaction to ensure that Reckon Accounts tracks the correct 
amount for each business. As you split the transaction, assign the correct tag to the appropriate amount in the 
Split Transaction dialogue.

•	 Avoid adding more than one business tag to a transaction.

When a transaction includes more than one business tag, Reckon Accounts can’t tell how much of the 
transaction belongs to each business. For this reason, Reckon Accounts doesn’t display the transaction for any 
of the businesses you can select in the Show column above the Profit & Loss snapshot, but instead displays the 
transaction as an Unknown Business.

•	 Business tags can be added to transactions that are not in a business account.

One of the advantages of business tags is that they let Reckon Accounts know that the transactions that include 
them belong to a business, even if the transaction is recorded in a personal account instead of a business 
account. 
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Reviewing your business data

After you add the business tag and apply the business tag to the appropriate transactions, Reckon Accounts displays 
the data for your business in a number of ways.

•	 Reckon Accounts business reports display information about your business in a clear, easy-to-read format. 
Available reports include tax reports, profit and loss statements, balance sheets, and reports that track expenses 
and income by project. 

•	 The Business Cash Flow page helps you track and manage the short-term income and expenses for your 
business. 

•	 The Profit/Loss page shows your income, expenses, and net profit or loss for each business you track in Reckon 
Accounts. 

•	 Reckon Accounts includes the balances of your business accounts along with the balances of your personal 
accounts to determine your net worth, which you can review in the Financial Overview Centre or as a report. 

Setting up items to include on invoices

About invoices in Home & Business

Home & Business is a cash-basis accounting system only . It does not support an accrual basis accounting system. 
(Consider using Reckon Accounts Plus for your business if you need to support an accrual-based system.)

However, some businesses may still need to create estimates and invoices for clients, despite operating their 
business on a cash basis. For example, a professional musician will often need to provide a tax invoice to their client 
before payment, despite operating their business on a cash basis.

Home & Business allows you to create estimates and invoices, although you will have to enter payments as you 
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receive them into the relevant account manually.

Setting up items to include on invoices

To make working with invoices easy, you can set up invoice items to include on an invoice you create for a client. 
This reduces data entry when creating an estimate or invoice. You can create a invoice item for:

•	 Products you sell

•	 Hourly rate for services you provide (set up an item for each service, such as consulting, writing or research)

•	 Discount rates and special charges, such as surcharges

•	 Subtotals

To set up a new item:

Go to the Business menu, click Invoices and Estimates, then click Invoice Items.

Home & Business displays the following window.
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You can also set up 
discount items that 
are used to calculate 
discounts on invoice 
items

Invoice items 
can include 
products or 
services

An invoice represents any product you sell. You can use invoice items for tangible goods or services that you sell at a 
per item or hourly rate. You can also use invoice items for one time charges. For example, a consultant might have a 
Consulting Fee item for his/her hourly billing rate, plus a Marketing Manual item for a product he/she sells. An auto 
body shop might have a Labour item for its hourly billing rate, plus several items for auto parts or other products it 
sells.

When you set up a new item, enter a name, description, and the amount you charge. For services, enter your hourly 
billing rate as a Per Item Rate. (For example, if the item is an hour of Design Consulting, you could enter a Per Item 
Rate of $45.00) And, if the item is taxable, select the Taxable check box.

When you’re ready to create an estimate or invoice, much of the work is already done. Just choose items from your 
item list and enter the quantity – Home & Business calculates the totals for you.

If you sell dozens of products or parts, just set up a few major items types, and then edit the item price when you 
enter it on the invoice. (If you need to track an extensive inventory, consider using Reckon Accounts Plus.)

Getting started with Reckon Accounts
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Discounts, special charges and subtotals

A discount or special charge is an invoice item that adds a positive or negative percentage to the item that 
immediately precedes it on the invoice.

You can create a discount item from the New Item dialog as you would a normal invoice item. However, you need 
to specify a percentage to apply against the discounted item. The value of the item then becomes the value of the 
previous item multiplied by the percentage you just specified. A negative percentage makes it a negative value 
(discount) and a positive percentage makes it a positive value (special/additional charge).

Applying a discount to one item

To apply a discount on an invoice, enter the item for discount as usual in the Invoice form, then add the Discount 
item in the line that immediately follows the item for discount. Home & Business calculates the discount.

Chapter 3



55

Entering a negative percentage makes the item a discount item. Entering a positive percentage 
makes the item an additional charge item.

Applying a discount to several items

We’ve just learned that a discount or special charge item applies its percentage to the value of the previous item on 
the invoice list. What if you wish it to apply to a series of items? 

You will need to use a subtotal item, which is an item that takes on the value of all items that precede it on the 
invoice list. Add the discount or additional charge item after the subtotal so that it works with the subtotal of all 
items.

You can create a subtotal item from the New Item dialog as you would a normal invoice. However, call it subtotal 
and select the Subtotal of the Preceding Items check box.

Getting started with Reckon Accounts
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Name the item 
subtotal.

Select the Subtotal 
of the Preceding 
Items check box.

To apply a discount or special charge to several items, enter the subtotal item after the items you wish to subtotal, 
and then add your discount or special charge on the invoice.

To learn more about creating new items or the Item List, go to the Help menu and click Product Help. Click the 
Search tab, enter “invoice item”, and select items on an invoice.

Chapter 3
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Setting up customers

You can record information about customers so that Home & Business can populate relevant information in the Bill 
To and Ship To fields of an estimate or invoice. Apart from making your data entry faster, this feature also enables 
you to store additional information about a customer that might help you improve your service.

Customer information is stored in your address book, which is also where you can store information about suppliers, 
family, friends and other contacts.

To add a new customer to your records:

1.	 Go to the Business menu, click Customers and then click Add Customer.

The Edit Address Book Record window opens.

This check box 
will be selected 
when you open 
this window. It 
enables Home 
& Business 
to categorise 
information you 
enter as relating 
to a customer.

This is where 
you enter 
information 
about your 
customer.

2.	 Enter information in the fields as you consider relevant to your situation.

Getting started with Reckon Accounts
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Take time to explore the type of information you can enter for the customer. It depends on your business needs 
as to whether you wish to record contact, secondary, personal or miscellaneous information. Although some 
of this information may not be relevant to completing an invoice, it could be used for business promotions or 
increased service.

3.	 Click OK.

When you enter the name of a customer in an estimate or invoice, it will automatically enter details stored for that 
customer in the Address book.

Setting up suppliers

You can record information about suppliers so that Home & Business can populate fields in an estimate or invoice 
with relevant supplier information. Apart from making your data entry faster, it also enables you to store additional 
information about a supplier that might help you in your dealings with that supplier.

Supplier information is stored in your address book, which is also where you can store information about customers, 
family, friends and other contacts.

1.	 Go to the Business menu, click Bills and Suppliers and then click Add Supplier.

The Edit Address Book Record window opens.

Chapter 3
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This check box 
will be selected 
when you open 
this window. It 
enables Home 
& Business 
to categorise 
information you 
enter as relating 
to a supplier.

This is where 
you enter 
information 
about your 
supplier

2.	 Enter information in the fields as you consider relevant to your situation.

Take time to explore the type of information you can enter for the supplier. It depends on your business needs as 
to whether you wish to record contact, secondary, personal or miscellaneous information. Although some of this 
information may not be relevant to completing an estimate or invoice, it could be used for business promotions or 
increased service.

3.	 Click OK.

When you enter the name of a supplier in an estimate or invoice, it will automatically enter details stored for that 
supplier in the Address book.
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PERFORMING EVERYDAY PERSONAL TASKS

4
Everyday personal tasks in Reckon Accounts 62

Updating your cash flow accounts 62

Assigning transactions to categories 67

Reconciling your cash flow accounts 70

It’s important to keep good records of your personal accounts so that you can improve your 
finances and identify areas that need strengthening.

This chapter looks at how to record your everyday personal financial transactions. It includes 
how to record financial activities in your cash flow accounts, use categories, reconcile 
transactions, and more.
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Before you start

Think about the everyday transactions recorded in your standard accounts. This chapter discusses the 
kind of tasks you’ll perform in Reckon Accounts using these accounts.

For this chapter, you will need your most recent statements for the chequing, savings, and credit card 
accounts you plan to track with Reckon Accounts.

Everyday personal tasks in Reckon Accounts
Managing your personal finances is an everyday task; it never stops. Money is always exchanging hands - from 
receiving your pay cheque and paying off your loans to purchasing new home appliances, weekly tickets for public 
transport or buying a coffee before work. Where does it come from? Where does it go?

You might not be in a position to record your money movements each day in Reckon Accounts, but it’s a good idea 
to track your everyday money movement regularly in the program so that you can see how effective your financial 
management is.

This chapter looks at the basics of recording those everyday financial activities in Reckon Accounts. We’ll look at how 
you can enter transactions and categories to help you understand what you spend your money on.

Updating your cash flow accounts
You should manually enter all new transactions as they occur. That is, each time you write a cheque, make a deposit, 
or transfer funds, enter that information in Reckon Accounts. Use the following guidelines to help you decide which 
transactions to enter when you first begin using Reckon Accounts.
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If you reconciled your last bank statement (that is, if you balanced your cheque book), then enter all your 
outstanding transactions. This should include those that weren’t cleared on the statement and those that have 
taken place since you reconciled.

If you didn’t reconcile your last bank statement, enter only transactions that took place after the statement date that 
you used when you added the account. (If you enter any transactions that took place before you added the account, 
some of them might be accounted for twice—once in the amount you entered for the Opening Balance when you 
added the account, and once when you enter them again.)

Open the register

1.	 Go to the Cash Flow menu and click Go to Cash Flow Centre if your register isn’t displayed.

2.	 In the upper-right corner, click My Data.

3.	 In the Spending & Savings Accounts snapshot, click the account you want to open.
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Open the accounts you add from the snapshot in the centre or 
the Account Bar list

Click the MINUS sign 
(-) to minimise the 
Account Bar list and 
the PLUS sign (+) to 
expand it.

You can also click to 
expand and minimise 
the list of accounts.

Reckon Accounts opens the register and selects an empty transaction.

Click this field to begin 
entering a transaction

Click this field to 
assign a category to the 
transaction

Click this button to 
save the transaction



65

Enter a payment transaction

1.	 Select an empty transaction at the bottom of the register.

2.	 Enter a date, a cheque number, a payee such as “Any Town Water”, and a payment amount. (You can use the 
mouse or the TAB key to move from one field of the transaction to the next.)

3.	 In the Category field, select a category.

4.	 In the Tag field, select a tag. (Optional)

5.	 In the Memo field, type a memo or note. (Optional)

6.	 Click Enter to save the transaction.

That’s it! You’ve entered a payment transaction. Keep going to learn about entering other kinds of transactions.

Transfer funds to another account

After you have set up multiple accounts within the same data file, you can transfer funds between them. For 
example, if an annual bonus is deposited into your chequing account, you can transfer some percentage of the 
bonus to your savings account.

If you haven’t set up multiple accounts in Reckon Accounts, skip to the next section, “Enter a deposit.”

1.	 Open the register for the account that you want to transfer money from.

2.	 On the toolbar, click Transfer.

3.	 Reckon Accounts displays the Record a Transfer between Accounts dialog with the current account selected in 
the Transfer Money From field.

4.	 In the To Account field, select the account you’re transferring money to.

Performing everyday personal tasks
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5.	 In the Memo field, type a memo or description. (Optional)

6.	 In the Date field, enter the date of the transfer.

7.	 In the Amount field, enter the payment amount.

8.	 Click OK.

Reckon Accounts enters the transfer transaction in the register. The account you have made the transfer to 
appears in the Category field in [square brackets].

Enter a deposit

1.	 In the Date field, enter a date.

2.	 In the Num list, select Deposit.

3.	 In the Paid by field, enter from whom the money came (for example, Income Tax Refund).

4.	 In the Deposit field, enter the deposit amount.

5.	 In the Category field, select a category, or click Split to split the deposit among multiple categories.

6.	 In the Tag field, select a tag. (Optional)

7.	 In the Memo field, type a memo or note. (Optional)

8.	 Click Enter to save the transaction.

On an ongoing basis

Continue to enter all new transactions as they occur. Also, reconcile your account each time you receive a new 
bank statement (see the next section, “Reconcile your cash flow accounts”). Reconciling ensures that your account 
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accurately reflects all your banking activities. Reconciling is a great way to catch transactions that you forgot to 
enter or entered twice.

Assigning transactions to categories
Make sure all your transactions are assigned to the correct category. For more information about categories, see 
“Learning how categories help manage your finances” on page 32. You can assign a transaction to one or more 
categories.

Assign a transaction to a single category

1.	 In most cases, you’ll want to assign the full amount of a transaction to a single category.

2.	 Select the transaction you want to assign a to a category, or change a category for. 

In the Category field, select a category, such as Utilities:Water or, if Reckon Accounts has assigned a category 
for you, confirm that the category is appropriate for the transaction. (If you don’t see the Category list, click the 
Category arrow.)

Performing everyday personal tasks



68

If you don’t see a category that reflects the purpose of the transaction, you can create one. At the 
bottom of the category list, click Add Category, and enter the information that Reckon Accounts 
requests. You can use the category for any transactions you add from now on.

3.	 Click Enter to save the transaction.

When you click Enter to save a transaction, Reckon Accounts updates your data file on your computer’s hard 
disk. That means that you don’t have to save the file yourself. However, it’s a good idea to back up the file to 
another location on a regular basis; for more information, see “Back up your data file” on page 24.

Assign a transaction to multiple categories

Sometimes you need to assign a transaction to two or more categories. This is called a split transaction.

1.	 Select the transaction you want to assign to two or more categories.

2.	 In the lower-right corner of the transaction, click Split.

The Split Transaction window opens.

Chapter 4
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Click the Split button to assign a 
transaction to multiple categories

This transaction is assigned to three categories. The 
[Petty Cash] line is a transfer to your cash account.

Performing everyday personal tasks
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3.	 On each line, select a category, enter a tag (optional), enter a memo (optional), and enter the amount to be 
assigned to the category. Repeat until you have split the transaction among all the appropriate categories and 
the sum of their amounts equals the transaction total.

4.	 Click OK to save the split information.

5.	 Click Enter to save the transaction

Split transactions are useful for breaking single transactions into several categories (for example, 
when you purchase both food and medicine at the supermarket). However, split transactions aren’t 
the ideal way to enter all the monthly transactions for a credit card. The best way to track credit card 
purchases is to create an account for the credit card and then enter each purchase as a separate 
transaction.

That’s it! Now you’re ready to review your accounts.

Reconciling your cash flow accounts
When you finish updating and accepting transactions into a account, or you receive a statement for an account that 
you’re tracking in Reckon Accounts, reconcile your Reckon Accounts data.

Reconciling ensures that your Reckon Accounts data is correct and can also help you discover any errors. You can 
reconcile almost any type of cash flow account, including chequing, savings, and credit cards.

Reconciling an account to a statement 

When you receive a statement for an account that you’re tracking in Reckon Accounts, you should reconcile the 

Chapter 4
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statement with your Reckon Accounts data. If you’re updating transactions for the account, you must take care to 
account for transactions that occur after the ending statement date.

1.	 Open the account register.

2.	 On the toolbar, click Reconcile.

The Statement Summary dialog opens.

3.	 Use your bank statement to enter the requested information (i.e., Ending Balance). 

Reckon Accounts calculates the opening balance for you. Click the Help icon if you need more information. 
When you’re finished reconciling, you can have Reckon Accounts make any needed adjustments in your register.

4.	 Click OK.

Reckon Accounts displays the Statement Summary window without any transactions selected. Select each 
transaction that appears on your statement to mark it as cleared in Reckon Accounts.

It’s a good idea to tick off each transaction on the paper statement as you go along, too. When you finish 
reconciling, cleared transactions will have an “R” in the Reckon Accounts register’s Clr column.

5.	 (Optional) Add transactions that are on your statement but which aren’t listed in the Statement Summary 
window.

▪▪ Click New on the toolbar to add transactions to the register.

▪▪ Click Return to Reconcile in the register to return to the Statement Summary window.

6.	 Click Finished when the difference shown in the lower-right corner of the Statement Summary window is 0.00.

If the difference shown in the lower-right corner of the window is not 0.00, decide how you want to resolve the 
discrepancy. You may have forgotten to enter a transaction, or accidentally entered one twice.

Performing everyday personal tasks
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For example, perhaps your financial institution has recorded a service charge or dividend that you haven’t 
entered into Reckon Accounts yet. Go to the Help menu and click on Product Help. Click the Search tab, then 
enter “reconciling” to get information about resolving reconciliation discrepancies.

If the difference still is not 0.00, your best bet is to click Finished and let Reckon Accounts add an Adjust Balance 
transaction for you.

7.	 (Optional) Click Yes to print a reconciliation report.

Chapter 4
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MANAGING YOUR INVESTMENTS

5
Deciding which accounts to track 74

Adding your investment accounts 76

Tracking your portfolio’s performance 79

Updating your investment accounts 88

Adding a superannuation account 93

Tracking your investment properties 95

Reckon Accounts helps you to track your personal investments. This chapter explores how you 
can track different types of investments, such as shares, managed funds, superannuation and 
investment properties.
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Before you start

Think about the types of investment accounts you want to track in Reckon Accounts, including 
brokerage accounts, superannuation, and so on.

What you’ll need

You’ll need the last statement you received for each investment and retirement account that you plan to 
track in Reckon Accounts.

When you’re ready to capture cost basis and capital gains information for an account, you’ll need all 
past and current statements for the account.

Deciding which accounts to track
In this chapter you’ll learn how to set up brokerage and superannuation accounts in Reckon Accounts.

For information about adding other types of investment accounts, go to the Help menu and click Product Help. 
Click the Search tab, enter “add investment accounts”, and then click Ask.

The following table can help you decide which account types best suit your financial situation.
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To track this real-world account Add this Account type

Investments such as stocks, including stock options and employee stock purchase shares, bonds, and 
funds. (If you write cheques or use a debit card against this type of investment account, you can also 
track those transactions.

Brokerage

Superannuation accounts Superannuation

Managed or trust funds that meet the following requirements: 

•	 you purchase them directly from the managed or trust fund provider; 

•	 they are tracked in accounts by themselves; and 

•	 the managed or trust fund company reinvests earnings and dividends in the same security so the 
account does not carry a cash balance.

Single Managed Fund

Term Deposit 

You invest a lump sum of money where the interest rate is guaranteed not to change for the 
nominated term. Normally the money can only be withdrawn after the term has ended.

Term Deposit

(New Zealand version only) KiwiSaver

You build up your savings through regular contributions from your pay. Your KiwiSaver savings are 
made up of contributions to your account, plus or minus investment returns, minus any withdrawals, 
fees and taxes.

KiwiSaver

(New Zealand version only)
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Adding your investment accounts
1.	 Go to the Investing menu and click Go to Investing Centre.

2.	 In the upper-right corner, click Today’s Data.

3.	 In the Investment & Retirement Accounts snapshot, click Add Account.

The Account Setup dialog opens.

4.	 Select Brokerage, then click Next.
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5.	 In the This account is held at the following institution field, enter the name of the financial institution that 
holds this investment account, then click Next.

If your financial institution is in the list that Reckon Accounts displays, select it. If it’s not in the list, type its name. 
Be sure to correctly identify your financial institution. Reckon Accounts needs the official company name—not 
an abbreviation—to determine which services are offered by that institution.

6.	 In the Name this account field, type the name by which you want to refer to this account in Reckon Accounts, 
then click Next.

7.	 Choose the currency for this account from the Currency drop-down list, then click Next.

8.	 If this is a tax-deferred account, choose Yes, otherwise choose No, then click Next.

9.	 In the Statement Date field, enter the date you’re using to set up holdings in this account, then click Next.

▪▪ If you’re entering this information from a brokerage statement, use the statement ending date.

▪▪ If you’re entering this information from your brokerage’s Web site, use the date that your information was 
posted (probably the date you accessed the site or the day before).

10.	In the Cash Balance field, enter the cash balance for the account in the way your financial institution displays it, 
then click Next. You may need to use both fields, or just one or the other.

11.	Identify the securities in the account, then click Next.

▪▪ If you don’t have Internet access, in the Security Name field, type the name of each security you want to add 
to the account.

▪▪ If you have Internet access, you can search for your security’s ticker symbol by clicking Stock Symbol 
Lookup.

▪▪ Click Next to enter information about your holdings.
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12.	Type the total number of shares, and identify the security type for each security.

13.	Click Next to see a summary of the information you have entered for your accounts. 

14.	Click Done.

If you used a currency other than your default currency, Reckon Accounts asks you to enter the exchange rate in 
terms of your default currency per the currency chosen for this account. Enter the exchange rate, then click OK.

Now you’re ready to add your holdings to the account. For information about how to add your holdings, see 
“Keeping your investment data current” on page 92. Then you’ll be ready to see how your investments are 
performing as described in the next section, “Tracking your portfolio’s performance.”
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Tracking your portfolio’s performance
Reckon Accounts makes it easy to track the performance of your investments in a way that emphasises what’s 
important to you. The Investing Centre provides a number of ways to view your investing and retirement accounts 
along with many useful tools to help you analyse and manage them.

You’ll find a different focus on each page of the Investing Centre. Go to the Investing menu, click Go to Investing 
Centre, and then click the button that has the information you want.

Today’s Data focuses on information that 
changes frequently and helps you see how 
market changes affect the securities you own or 
watch.

Performance provides an in-depth review of your 
investments over time, so you can measure the 
performance of your investments against key 
benchmarks.

Analysis focuses on how your current investments 
are divided among asset classes and how your 
mutual funds are doing compared to others.

Portfolio focuses on an in-depth 
review of your portfolio as a 
whole.

In this section, you’ll learn how to use some of the performance and analysis tools in the Reckon Accounts Investing 
Centre. For example, you’ll learn how to:

•	 Set up a watch list to track the securities you want to follow.

•	 Keep track of the average annual return for your investments.
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•	 Determine the right asset allocation for you.

•	 Use the Portfolio to answer your top investment questions.

•	 Create reports that summarise your investment-related data.

Track the securities you want to follow

1.	 Go to the Investing menu and click Go to Investing Centre.

2.	 In the upper-right corner, click Today’s Data.

3.	 In the Watch List snapshot, click Add a security.

Click Download Quotes to keep the 
information in your Watch List current.

4.	 Follow the on-screen instructions; click Next to move through the pages. Click the Help icon if you need more 
information.
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To track market indexes in the Watch List, click Edit Watch List, and select the Watch check box for 
each market index you want to display. If the market index you want to follow isn’t in the Security 
List, click Choose Market Indexes at the top of the Security List to add it.

Track your average annual return

Your average annual return, often called the internal rate of return (IRR), is the cumulative total return on your 
accounts expressed as an annualised figure. It includes dividends, interest, and other payments you receive, 
plus increases and decreases in the market value of your securities. Generally, if the average annual return on an 
investment is 10 percent, that investment is performing as well as a bank account that pays 10 percent interest in 
the same time period.

For information about how Reckon Accounts calculates this and other investment performance measures, go to the 
Help menu and click Product Help, then click the Search tab, enter “average annual return”, and click Ask.

You can view the average annual return for an individual account, all accounts, only investment accounts, or only 
superannuation accounts.

1.	 Go to the Investing menu and click Go to Investing Centre.

2.	 In the upper-right corner, click Performance.

3.	 On the Performance toolbar, select whether you want to view the average annual return for all accounts, 
investment accounts only, superannuation accounts only, or for a customised group of accounts.

4.	 In the Average Annual Return snapshot, view the average annual return for your accounts. 

Reckon Accounts displays annualised figures for 1 year, 3 years, and 5 years.
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In the Average Annual Return window:

•	 Click Show security performance to see how each security is contributing to the total return for an account.

•	 Click Show security performance comparison to see how the total return for each security compares with the 
change in the stock’s industry over the same period.

Set a target asset allocation

Your current asset allocation shows how your current investments are divided among asset classes. You can view the 
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asset allocation for an individual account, all accounts, only investment accounts, or only superannuation accounts.

In this section, you’ll learn how Reckon Accounts can help you set up a target asset allocation. After you do, Reckon 
Accounts can help you determine if your current asset allocation is where it should be, and show you how to change 
it. For more information about asset allocation, go to the Help menu and click Product Help, then click the Search 
tab, enter “asset allocation”, and click Ask.

1.	 Go to the Investing menu and click Go to Investing Centre.

2.	 In the upper-right corner, click Analysis.

3.	 On the Analysis toolbar, select whether you want to view asset allocation for all accounts, investment account 
only, superannuation accounts only, or for a customised group of accounts.

4.	 In the Asset Allocation snapshot, click Show Allocation Guide.
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Use the Allocation Guide to set your asset allocation 
target and learn about rebalancing your portfolio.

5.	 Read the onscreen instructions.

6.	 Click How should I allocate my investments? on the right side of the Analysis window for detailed information 
on asset allocation.

Use the Portfolio

The Portfolio provides multiple views that answer your top investment questions. You can analyse the holdings, 
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performance, and price information for every security you own, across multiple investment accounts.

In this section, you’ll learn how to select a portfolio view. For more information about the Portfolio, go to the Help 
menu and click Product Help. Click the Search tab, enter “monitor portfolio performance”, and click Ask.

1.	 Go to the Investing menu and click Go to Investing Centre.

2.	 In the upper-right corner, click Portfolio.

The Portfolio window opens, displaying a list of portfolio views from which to select.

Select a default 
view, or click 
Customise View 
on the toolbar to 
create one of your 
own.

Reckon Accounts can 
group your investments 
for display by account, 
security, asset class, and 
so on.

In the Show list, select the view you want Reckon Accounts to display. For example, for an in-depth look at the 
short-term performance of your securities, select Recent Performance. For an in-depth look at the long-term 
performance of your securities, select Historic Performance.

Reckon Accounts displays information pertinent to the view you selected. (Move your pointer over a column 
heading for an explanation.) If you want to see account information that isn’t displayed in the default views, click 
Customise View to modify an existing view.

Managing your investments
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You can see some of the information in the portfolio views broken into smaller, graphical pieces 
in the Investing Centre. (Go to the Investing menu, click Go to Investing Centre, and then click 
Performance). For example, the Average Annual Return snapshot on the Performance tab and 
the Historic Performance view in the Portfolio both include information about average annual 
return.

3.	 In the Group by list, select how you want your investments grouped. (Optional)

4.	 In the As of field, enter another date. (Optional)

If the Portfolio displays asterisks indicating that data is missing, and you want to correct the issue, see “Improving 
the accuracy of your investment data” on page 88. For more information about missing data, go to the Help menu 
and click Product Help. Click the Search Reckon Accounts Help tab, enter “placeholders”, and click Ask.
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Run investment-related reports and graphs

1.	 Go to the Reports menu and click Reports & Graphs Centre.

The Reports & Graphs window opens.

2.	 In the Reckon Accounts Standard Reports list on the left, click Investing.

3.	 Select the report you want to run.

4.	 In the Date range field, change the date or date range for the report. (Optional)

5.	 Click Show Report. If the report has a corresponding graph, you can click Show Graph instead.

If the report displays asterisks indicating that data is missing, the bottom of the report includes a blue link called 
Placeholder Entries, followed by a blue link called Show me. Click Placeholder Entries to learn how to resolve 
placeholder entries. Click Show me to go to the place in Reckon Accounts where you can correct the issue. For 
information about when and why missing data is important, see “Improving the accuracy of your investment 
data” in the next section.

6.	 Click Customise to change the way the report is laid out or the scope of information it includes. Click the Help 
icon if you need more information. (Optional)

7.	 You can either close the report or choose one of the following options:

▪▪ Click the Print icon to print the report to paper or to a PDF.

▪▪ Click Save Report to save the report.

▪▪ Click Export Data to export the report to another program or to the Clipboard.

Click the Help icon if you need more information.

Managing your investments
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Updating your investment accounts
Now that you’ve seen the valuable performance and analysis tools in Reckon Accounts, you might be asking yourself 
what you can do to make your investment data more accurate and how can you can keep it current.

Improving the accuracy of your investment data

As you used some of the performance tools in Reckon Accounts, you may have noticed that some of the 
performance measures that you want to track include asterisks or/and other notations such as N/A indicating that 
placeholder entries for missing transactions are used in the calculations.

An asterisk indicates that Reckon Accounts does not have 
enough information to correctly calculate a particular value.

You can use placeholder entries to track holdings-only information in Reckon Accounts. They include the number of 
shares (along with the security name) that must be added to or subtracted from your Account to make it agree with 
the number of shares and the account balance at your brokerage. 

If the current value of your holdings is all you want to track in Reckon Accounts, you can leave the placeholder 
entries as they are and skip the rest of this section. However, if you want to take advantage of the detailed 
performance analysis and tax tools in Reckon Accounts, such as those described in “Tracking your portfolio’s 
performance” on page 79, continue reading.

The way to resolve all placeholder entries is to enter the date you bought the shares and cost basis information, 
which is the total amount you invest in a security you purchase. Cost basis includes commissions, fees, mutual fund 
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loads, and all purchases (even reinvestments of dividends and capital gains distributions), minus the cost of any 
shares you have sold or given away.

For each security that is missing transactions, Reckon Accounts adds an 

•	 Enter Cost link to the Transactions tab 

•	 Enter link to the Overview tab of the account where you hold that security. 

You can click either link to get started. 

As you enter the missing transactions that Reckon Accounts needs to calculate your cost basis, Reckon Accounts 
subtracts shares from the placeholder entry until it equals zero. Until you finish entering the complete transaction 
history, Reckon Accounts will identify those calculations and performance measures in the Portfolio, reports, and 
snapshots that are based on incomplete transaction information.

Managing your investments
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To enter cost basis information, click the Enter Cost link in the 
Transaction tab or the Enter link in the Summary tab.

Reckon Accounts gives you two options for entering missing transactions, each with its own requirements.

1.	 Enter Missing Transactions lets you add all the missing transactions needed to compare the historical 
performance of your securities over time, prepare accurate tax reports for both past and current holdings, and 
make informed tax decisions about your investments.

(For example, you’re in the ability to track lots, or securities grouped by common purchase prices and dates, 
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which are important for calculating the tax rate that applies to your capital gains; tracking this information can 
save you a lot of time and effort when you file your taxes.) 

This option is the only way to take full advantage of the tax and investment tools in Reckon Accounts. You’ll need 
the date you first purchased each security, the price you paid for it, and all transactions that have occurred since 
the purchase date.

2.	 Estimate Average Cost lets you improve the performance data for your current holdings. 

If you have held the account for many years or have a lot of transactions, this is a fast and easy way to get started 
until you can enter all your historical transactions. For each security, you’ll need the total cost of the entire 
holding or the average price you paid per share.

To enter missing information:

1.	 Go to the Investing menu and click Go to Investing Centre.

2.	 In the upper-right corner, click Today’s Data.

3.	 In the Investment & Retirement Accounts snapshot, click your investment account.

4.	 In the upper-right corner, click Transactions.

5.	 In the Transactions list, select the placeholder entry you want to resolve.

6.	 In the Inv Amt field, click Enter Cost.

The Enter Missing Transactions dialog opens.

7.	 Identify the amount of information you want to enter:

▪▪ Click Enter Missing Transaction to enter historical transactions. 

Use the Enter Transaction field to select each transaction you want to enter, and then enter the information 
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that Reckon Accounts requests.

▪▪ Click Estimate Average Cost to estimate the average price per share. 

▪▪ Enter your estimate in the Cost or Price/Share field.

Keeping your investment data current

Reckon Accounts includes forms to help you enter each type of investment transaction, and the forms are a good 
way to quickly become familiar with the kind of information each type of investment transaction requires. After 
you’re familiar with this information, you can enter investment transactions directly in the transaction list instead.

Regardless of how you enter investment transactions into Reckon Accounts, Reckon Accounts assigns the 
appropriate investment categories to the transactions and tracks the tax consequences for you. For this reason, you 
don’t want to change the investment categories in the Category List (go to the Tools menu and click Category 
List) that begin with an underscore (for example, _DivInc).

To enter investment transactions with investment forms:

1.	 Go to the Investing menu and click Go to Investing Centre.

2.	 In the upper-right corner, click Today’s Data.

3.	 In the Investment & Retirement Accounts snapshot, click your investment account.

4.	 In the upper-right corner, click Transactions.

5.	 In the upper-left corner, click Enter Transactions.

6.	 In the Enter transaction list, select the action you want to perform.

Investment transactions are at the top of the list, and cash transactions are at the bottom of the list.

Chapter 5
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Click Enter 
Transactions 
to open a 
dialog and 
select the 
action you 
want to 
perform.

7.	 Enter the information Reckon Accounts requests.

If you’re adding a bond, include the maturity date in the security name. This will help you distinguish it from 
other bonds in your portfolio and make it easy to match the information you download with the information in 
Reckon Accounts.

8.	 Click Enter/New to record additional transactions, and repeat steps 5 through 7. (Optional)

9.	 Click Enter/Done.

Adding a superannuation account
If you want the most comprehensive picture of your net worth, or if you want help planning for your retirement, be 
sure to track your superannuation accounts. In this section, you’ll learn how to add a superannuation account.

1.	 Get the superannuation statements that you want to enter into Reckon Accounts.

Managing your investments
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If you’re not concerned with historical information, you could start with your most recent statement and enter 
just your current holdings during setup.

If you want to include historical information for net worth purposes, choose the appropriate option:

▪▪ If your financial institution does not provide share balance information and transaction history, then you 
must decide on a starting date before you add the account. (Typically, you would get all your statements and 
enter holdings information in chronological order, starting with the oldest statement.) After you’ve added the 
account, you can’t enter statement information that occurred before the date of the earliest statement you 
use to set up the account.

▪▪ If your financial institution does provide share balance information and transaction history, then you can set 
up the account with just your most recent statement and enter your historical information at a later point, as 
described in “Improve the accuracy of your investment data” on page 88.

2.	 Go to the Investing menu and click Go to Investing Centre.

3.	 In the upper-right corner, click Today’s Data.

4.	 In the Investment & Retirement Accounts snapshot, click Add Account.

5.	 Choose the Superannuation radio button and then click Next.

6.	 In the This account is held at the following institution field, enter the name of the financial institution that 
holds this investment account, then click Next.

If your financial institution is in the list that Reckon Accounts displays, select it. If it’s not in the list, type its name. 
Be sure to correctly identify your financial institution. 

7.	 Follow the on-screen instructions; click Next to move through the pages. Click the Help icon if you need more 
information. When you finish adding the account, Reckon Accounts displays the Overview page for the account.
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8.	 Click the Transactions tab to add cost basis information, as described in “Improving the accuracy of your 
investment data” on page 88. (Optional)

For more information about resolving placeholder transactions for superannuation accounts, go to the Help menu 
and click Product Help. Click the Search tab, enter “placeholders”, and click Ask.

Tracking your investment properties (optional)
Reckon Accounts makes it easy for you to track your investment properties by introducing a special edition of 
Reckon Rental program. The Reckon Rental is an excellent analytical tool performing gearing analysis on your 
property purchases.

Reckon Accounts allows you to perform “what-if” scenarios on your currently existing property data. You’ll know 
immediately if the investment makes financial sense and whether there is significant tax benefits available and 
hence identify various ways of improving the financial viability of a property investment. In this section, you’ll learn 
how to track your investment properties.

1.	 Go to the Tools menu and select Reckon Rental.

The Property and Debt - Reckon Rental window opens.

Managing your investments
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2.	 In this window, select Use Existing Data and click Next.

Note that you may only be able to select the New Scenario option if you have purchased the full version of 
the Reckon Rental Professional. This option will create a blank scenario using new data in the Reckon Rental 
Professional product.

3.	 In the Accounts window, click the drop-down lists to select the accounts associated with the property you wish 
to analyse. These selections determine data transfer between Reckon Accounts and Reckon Rental.

If you select “None“ to the Liability or Asset account, it means the data for those accounts will not be included in 
the transaction history search.
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4.	 In the Categories window, click the drop-down lists to select the categories you used to track investment 
property.

The amount which will be transferred from Reckon Accounts to the Reckon Rental is the last amount entered 
against that category in the accounts that your selected in the Accounts window.

Managing your investments
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5.	 Continue on to assign categories in the following Categories window then click Next.
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6.	 In the final window, review the on-screen information and click Finish.

Click Back to move through the pages if you need to modify the information that you perviously entered.

7.	 The Reckon Rental program launches.

For more information about how to use Reckon Rental for your investment properties, click the Help button in 
the Reckon Rental program.

You will not be able to edit the data which is transferred from Reckon Accounts or print any reports 
in the Reckon Rental if it has not been upgraded into the Professional edition. In order to use the 
full Reckon Rental Professional product you will need to purchase a licence. Call Reckon customer 
service on 1300 784 253 for more information.

Managing your investments
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6
Learning how Reckon Accounts helps you plan for tax time 102

Tracking your paycheque 103

Tracking your tax-deductible expenses 112
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Learning about the Capital Gains Estimator 118

Tax time can be a good time of the year for the possible tax refunds you might get from your 
local tax office. It can also be a headache if you haven’t kept you records properly. Reckon 
Accounts makes record keeping easy so you can comfortably enter tax time prepared for the 
best result. In this chapter, we’ll see how to track your paycheque and tax-deductible expenses, 
and how to use the Tax Planner.
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Before you start

As a minimum, you should complete Chapter 3, being sure to add the account into which you deposit 
your paycheque.

What you’ll need

You will need a recent payslip.

Learning how Reckon Accounts helps you plan for tax time
Reckon Accounts includes several tools to help you track your tax-related income and expenses. The Tax Centre 
provides the most commonly used tools along with a summary of your tax-related data and reminders about 
upcoming tax-related dates.

Tracking tax-related information in Reckon Accounts can be useful throughout the year, long before the start of 
the new financial year. For example, Reckon Accounts can use your data to help you determine if you’re having too 
much or too little deducted from your paycheque. You can also review your deductible expenses on an ongoing 
basis.

The more tax-related information you track in Reckon Accounts, the easier your life can be when tax time does roll 
around. You can also use Reckon Accounts to print reports that consolidate a year’s worth of information into a few 
pages; copy the figures onto your tax forms, and your work is practically complete.

In this chapter, you’ll learn how to use some of the tax tools in the Reckon Accounts Tax Centre. In particular, you’ll 
learn how to:
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•	 Add a paycheque transaction that tracks your gross income and all the deductions taken out of each paycheque.

•	 Keep track of tax-deductible expenses.

•	 Use the Tax Planner to estimate your tax liability and investigate difference “What if” scenarios.

•	 Create reports that summarise your tax-related data.

Tracking your paycheque
While you could choose to enter the net amount of your paycheque as a deposit in your register, if you do so 
you lose all the details about the paycheque, such as amounts added to your superannuation or deducted for 
your income tax. Therefore, Reckon Accounts provides a special paycheque feature that tracks gross amounts, 
deductions, and net amounts for each paycheque. This simplifies a great deal of your tax planning in Reckon 
Accounts.

Even if you initially added only the net amount of your paycheque in Reckon Accounts (as would be the case for any 
paycheques added during Express Setup), you can still use the paycheque feature to add deduction information 
now.

The paycheque feature also works if your paycheque varies from one pay period to the next. Just adjust the details 
as necessary when you enter the paycheque transaction.

Adding a paycheque

When you use a recent payslip to add the financial details from your paycheque, Reckon Accounts remembers these 
details each time you enter a paycheque into the register.

You receive the maximum benefit from the tax tools in Reckon Accounts (such as the Tax Planner) by setting up your 
paycheque at the beginning of the tax year. If you’re not setting up your paycheque at the beginning of the tax year, 
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Reckon Accounts helps you to adjust your year-to-date (YTD) totals.

Use this procedure to add a new paycheque to Reckon Accounts. If you simply want to add deduction information 
to a paycheque added to Reckon Accounts (for example, during Express Setup), then skip to the next section, 
“Adjusting a paycheque.”

1.	 Go to the Tax menu and click Go to Tax Centre.

2.	 In the Taxable Income YTD snapshot, click Add Paycheque.

In Reckon Accounts New Zealand, go to the Cash Flow menu and click Set Up 
Paycheque.

Reckon Accounts displays the Paycheque Setup wizard. (If Reckon Accounts displays the Manage Paycheques 
dialog instead, click New to open the Paycheque Setup wizard.)

3.	 In the Paycheque Setup wizard, click Next.

4.	 Follow the on-screen instructions; click Next to move through the pages. Click the Help icon if you need more 
information.

You will enter most of the information on the following page.
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Use the following guidelines as you add the information about your paycheque:

▪▪ Select the account into which you want to deposit the paycheque.

▪▪ Enter the date of the first deposit, when Reckon Accounts should remind you to enter your paycheques into 
the account register, and how often you’re paid. Click the double arrows (>>) to the left of Scheduling to 
display the required fields if necessary.

▪▪ Click Edit on the right side of the appropriate area to enter the figures for gross pay and deductions from 
your recent payslip in the Setup Paycheque dialog, or to change the name, category, or amount of a 
paycheque item.

You can edit the amount of a paycheque item directly, or you 
can click the Edit button to change the name, category, and 
amount of a paycheque item all at one time.

▪▪ Click the Add button in the lower-left corner of the appropriate area to add a paycheque item to the Setup 
Paycheque dialog. For example, to add items for bonuses, profit sharing, or vacation, holiday, or sick pay, 
click Add Earning; to add items for superannuation plans, or flexible spending accounts, click Add Pre-Tax 
Deduction; to add items for employee stock purchase plan deductions or loan repayments, click Add After-
Tax Deduction.

▪▪ To adjust the year-to-date (YTD) totals so you can use the tax tools in Reckon Accounts, specify that you want 
to enter this information in the Enter Year-to-Date Information dialog that Reckon Accounts displays after 
you click the Done button in the Setup Paycheque dialog. (This is the only chance you’ll have to enter this 
information in the Paycheque Setup wizard.) Otherwise, tell Reckon Accounts to skip this step, and then 
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enter this information in the Tax Planner as you go along. For more information about entering year-to-date 
information, go to the Help menu and click Product Help. Click the Search tab, enter “paycheques year-to-
date information”, then click Ask.

5.	 In the Manage Paycheques dialog, click Done when you have finished adding your paycheque and YTD totals.

Adjusting a paycheque transaction

If you get a raise or change jobs, or if other activities permanently affect your paycheque, future paycheques should 
reflect this new information.

If you used Express Setup to add your paycheque to Reckon Accounts, you can also use this procedure to add 
deduction information.

1.	 Go to the Tax menu and click Go to Tax Centre.

2.	 In the Taxable Income YTD snapshot, click Edit Paycheque.

3.	 In the Manage Paycheques dialog, select your paycheque.

4.	 Click Edit, make any necessary changes, and click Done.

▪▪ If you want to change when Reckon Accounts reminds you to enter your paycheque into the account register 
or how often you’re paid, click the double arrows (>>) to the left of Scheduling.

▪▪ If this paycheque was added to Reckon Accounts as a net deposit (as would be the case if you added the 
paycheque during Express Setup), you may need to click Track Deductions to display the fields where you 
enter your deductions.

Click the Help icon if you need more information.

5.	 In the Manage Paycheques dialog, click Done when you have finished adjusting your paycheque.
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Entering or editing a scheduled paycheque transaction

If you told Reckon Accounts to remind you to enter your paycheque into the register when it’s due, Reckon Accounts 
places a reminder about the paycheque on the Scheduled Bills & Deposits tab at the bottom of the appropriate 
register. It is then up to you to enter the transaction in Reckon Accounts based on the reminder.

Reckon Accounts also places a reminder for all scheduled transactions on the Cash Flow page in the Cash Flow 
Centre, and on the Reckon Accounts Home page. Here you can see any scheduled transaction you have set up as a 
reminder ready to enter into the relevant Reckon Accounts register.

Let’s use the reminders in the Cash Flow Centre to first edit your paycheque, and then enter it as a transaction into 
Reckon Accounts.

1.	 Get your most recent payslip.

2.	 Go to the Cash Flow menu and click Go to Cash Flow Centre.

3.	 Locate the paycheque transaction in the Deposits and Other Scheduled Transactions in the Scheduled Bills & 
Deposits area

There is a paycheque transaction in this example. 

See if you can find the paycheque you just set up in your list.

4.	 (Optional) Click Edit against the paycheque transaction in the Deposits and Other Scheduled Transactions 
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snapshot to edit any individual elements of the paycheque for future reference.

The Edit Future Paycheques window opens.
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5.	 Do any of the following:

▪▪ Change the company name if you’re now in a new job

▪▪ Change the account to deposit funds if you wish to track them in another Account

▪▪ Change the amount if your amount has changed, perhaps due to a pay rise

▪▪ Add a memo if necessary to all future paycheques

▪▪ Re-organise the schedule by clicking the “<<” (Scheduling) button

6.	 Once you have finished, click Done.

7.	 Click Enter at the right side of the window under Action.

The Enter Paycheque into Register window opens.
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This is where you enter your paycheque amount into the register. The amount defaults to what you set up in the 
Paycheque wizard. However, you can change the amount if your pay changes.

8.	 Click Help for more information.

9.	 Click Enter to add the paycheque transaction to your register.

You can also add scheduled transactions to Reckon Accounts for other transactions that occur at regular 
intervals, such as bill payments, deposits and account transfers.

Tracking your tax-deductible expenses
Reckon Accounts can link categories to specific lines on a tax form. (Categories are discussed in detail in “Assigning 
transactions to categories” on page 67.) Linking categories to tax forms automates the process of tracking income 
and tax-related expenses.

Using standard tax-related categories

Reckon Accounts links the most common tax-deductible categories and subcategories to tax forms. If you added a 
paycheque to Reckon Accounts in the previous section, you may have noticed that your income was assigned to the 
Salary category and that deductions were assigned to categories and subcategories.

To see a full list of standard tax-related categories in Reckon Accounts, open the Category List:

1.	 Go to the Tax menu and click Go to the Tax Centre.

2.	 In the Tax-Related Expenses YTD snapshot, click Assign Tax Categories.
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The Tax Line Item column indicates the tax form and line item associated with the category. If a category 
doesn’t have the appropriate tax form line item associated with it, you can edit the category. Click the Help icon 
for more information.

Click the tab 
for the type of 
category you 
want to see

Click the Show drop-down arrow to 
select only tax-related categories

Change the tax 
line item for a 
category in the 
Edit Category 
dialog. To open 
it, select the 
category you 
want to change 
and click the 
Edit button.
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Reviewing tax-related categories

If you have added your own tax-related categories or changed a standard category’s tax line item, Reckon Accounts 
can help you make sure that you have assigned the correct tax line item.

1.	 Go to the Tax menu and click Tax Category Audit.

Reckon Accounts checks all your categories and lists the categories that meet the following criteria:

▪▪ Standard Categories aren’t linked to their original tax line items, or are linked to incorrect tax line items.

▪▪ User-defined Categories may need to be linked to different tax line items.

2.	 Select the appropriate action for each category Reckon Accounts displays.

▪▪ Click Change to edit a category, make the necessary changes, and click OK. Click the Help icon for more 
information.

▪▪ Click Ignore to leave the category unchanged.

Using the Tax Planner

This feature applies to the Australian version only.

Use the Tax Planner to prepare for the inevitable. After you add a paycheque to Reckon Accounts and assign tax 
categories to a few tax-related expenses, you already have a wealth of tax-related data at your fingertips. The Tax 
Planner can use your Reckon Accounts data to help you anticipate the current year’s tax liability. You can then adjust 
your payroll withholding if necessary. You can also evaluate the tax implications of various tax-related financial 
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actions, such as buying a home or selling stock.

To work effectively, the Tax Planner needs year-to-date information for your gross pay and deductions. If 
you did not add your paycheque at the beginning of the tax year and did not add year-to-date information 
when you added your paycheque to Reckon Accounts, add this information as you go along. 

If you need assistance, click the question mark in the upper-right corner of the Tax Planner window. 
You can also go to the Help menu and click Product Help, then click the Search tab, enter “year-to-date 
information”, and click Ask.

To use the Tax Planner:

1.	 Go to the Tax menu and click Go to the Tax Centre.

2.	 In the Tools area at the upper-right side, click Tax Planner.

3.	 On the left side of the Tax Planner window, click How can Reckon Accounts help with Tax planning?

4.	 Read the on-screen instructions, and then click Let’s get started on the right side of the Tax Planner window.

Planning for Personal Tax Time
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Click Tax 
Planner 
Summary to 
see an overview 
of your tax 
situation.

Then click a 
tax item to see 
more detail.

At any time, you can click a schedule or worksheet on the left side of the window for more detail about a specific 
area.
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You can use your actual Reckon Accounts data, enter new values manually, or have Reckon Accounts base the 
calculations on scheduled transactions. If you need assistance, click the question mark in the upper-right corner of 
the Tax Planner window.

Any data that you enter manually will override any data you import from Reckon Accounts.

Running tax-related reports
You don’t have to wait until tax time to review your tax information. In fact, you probably won’t want to. Use the 
included tax reports to help you keep an eye on your tax information throughout the year.

1.	 Go to the Reports menu and click Reports & Graphs Centre.

The Reports & Graphs window opens.

2.	 In the Reckon Accounts Standard Reports list on the left, click Tax.

Reckon Accounts displays the list of available tax reports:

▪▪ Capital Gains displays short-term and long-term sales that are subject to capital gains tax.

If the report displays asterisks indicating that data is missing, the bottom of the report includes a blue link 
called Placeholder Entries, followed by a blue link called Show me. Click Placeholder Entries to learn how 
to resolve placeholder entries. Click Show me to go to the place in Reckon Accounts where you can correct 
the issue. For information about when and why missing data is important, see “Improve the accuracy of your 
investment data” on page 88.
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▪▪ Tax Schedule displays tax-related transactions subtotalled by tax form line item. If you plan to export tax 
information to tax software, this is the report to use. 

▪▪ Income Tax Summary displays tax-related transactions subtotalled by category.

3.	 Click the report you want to run.

4.	 In the date fields, change the date or date range for the report. (Optional)

5.	 Click Show Report.

6.	 Click Customise to change the way the report is laid out or the scope of information it includes. Click the Help 
icon if you need more information. (Optional)

7.	 You can either close the report or chose one of the following options:

▪▪ Click the Print icon to print the report to paper or to a PDF.

▪▪ Click Save Report to save the report.

▪▪ Click Export Data to export the report to another program or to the Clipboard.

Click the Help icon if you need more information.

Learning about the Capital Gains Estimator
Reckon Accounts also includes a Capital Gains Estimator, which helps you plan security sales so that you can 
maximise after-tax yields. Go to the Tax menu and click Capital Gains Estimator to open this feature, then follow 
the detailed onscreen instructions.

For more information about the Capital Gains Estimator, click the Help icon.
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PLANNING FOR BUSINESS TAX TIME

7
Home & Business and the GST 120

Setting up 121

Everyday tax transactions 136

Reckon Accounts Home & Business is designed to make tracking GST received and paid by your 
business easier to manage and report.

In this chapter we’ll look at how you can set up Home & Business to track GST before exploring 
the types of everyday activities you might perform that include GST.
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Before you start

You’ll want to have read and understood the previous chapters in this guide. This chapter will elaborate 
on the GST-related aspects of information covered earlier in the guide.

Home & Business and the GST
Reckon Accounts Home & Business supports tax tracking for your business. This includes tracking GST amounts in 
transactions, estimates and invoices and generating the figures for your BAS.

These features are only available in Reckon Accounts Home & Business, not Reckon Accounts Plus.

This chapter covers what you need to know about tracking tax in Home & Business, building on concepts and 
procedures covered earlier in this user guide. We’ve also included details of features designed to make the tax 
elements easier to use.

Information is organised into the three stages of using Home & Business for business:

•	 Setting up

•	 Everyday transactions

•	 Reporting and paying tax
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Setting up
When setting up Home & Business for tax, you need to configure the following areas according to your needs:

•	 Accounts

•	 Categories

•	 (Optional) Items

•	 (Optional) ABN Withholding account

Accounts. Home & Business tracks tax from transactions in accounts enabled to track tax. You therefore need to 
activate tax tracking within each business account. This enables Home & Business to record the tax code assigned to 
each transaction and calculate the tax amount for each transaction.

Once an account is enabled to track tax, you can use categories to help automate the application of the relevant tax 
rates when recording a transaction.

Categories. Categories specify the source of a deposit, the reason for an expenditure or the name of an account to 
which you might be transferring funds (see Chapter 4). You can also apply a specific tax code to a transaction.

When you apply a category to a transaction, the category information, including the tax code you set up, will apply 
to that transaction. This saves you having to enter tax code information manually. You can apply categories to 
deposits, purchases or invoices.

Invoice Items. An Invoice Item is something you create to represent a service or product you sell in your business. 
For example, a farmer that sells wheat might create an item called “wheat”. A music teacher who provides music 
tuition might create an Invoice Item called “music tuition”.

When setting up your item, you can associate it with a tax code. Home & Business then applies the associated tax 
code to the invoice line when you select that item on an invoice.
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It is therefore helpful to set up items to include a tax code.

ABN Withholding. If you pay for services from a contractor who doesn’t have an ABN, you may need to withhold 
a percentage of the amount payable. To track this in Home & Business, you need to create an ABN Withholding 
account.

Activating tax tracking for individual accounts

You can activate tax tracking for an existing account or activate it whilst creating a new account.

Turning on tax tracking for an existing account

1.	 Go to the Tools menu and click Account List, then double-click the account for which you wish to activate tax 
tracking.

Home & Business displays account details in Transactions view or Overview view. You can find the tabs at the 
top of the page.

2.	 Click the Overview tab if Home & Business displays the Transactions view.

Home & Business displays No against Tax enabled in the Account Attributes if Tax Tracking isn’t activated for 
this account.
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The Tax 
enabled 
attribute is set 
to No.

3.	 Click Edit Account Details at the base of the Account Attributes snapshot. Home & Business displays the 
Account Details window.

Planning for business tax time
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You can enable tax 
tracking for this 
account by setting 
the Tax-tracking 
enabled option 
to Yes.
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4.	 In the Tax-tracking enabled option, click the Yes radio button and then click OK.

Home & Business will return you to the Account Overview window with the Tax enabled attribute set to Yes.

You should now 
see that the Tax 
enabled attribute 
is set to Yes.

Planning for business tax time



126 Chapter 7

Turning on tax tracking when creating a new account

1.	 Go to the File menu and click New.

2.	 Click the New Account radio button and then click OK.

3.	 Select a business account type and then click Next.

4.	 Follow the onscreen instructions until you reach the window with the dialog: “Do you want to track Tax in this 
account?”

5.	 Select the Yes radio button and click Next.

6.	 Continue to follow the onscreen instructions until you have completed the Account Setup wizard.
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Assigning a default tax code to a category

You can assign a tax code to an existing category or assign it whilst creating a new category.

To see the list of tax codes available, go to the Business menu, click Business Lists, and then click Tax 
Code List. Refer to the How Do I menus from the Tax Code List for information about editing or creating 
new tax codes.

Assigning a tax code to an existing category

1.	 Go to the Tools menu and click Category List.

The Category List window opens.

Planning for business tax time
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2.	 Select a category and click Edit at the right side of the Category List.

The Edit Category window opens.

3.	 Select a tax code from the Usual Tax Code (optional) drop-down list.

Click the drop-
down arrow to 
choose from a list 
of tax codes to 
apply.

4.	 Click OK.
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Assigning a tax code when creating a new category

1.	 Go to the Tools menu and click Category List.

The Category List window opens.

2.	 Click New at the top right of the Category List.

The Set Up Category window opens.

3.	 Complete the Name, Description and Type fields.

4.	 Select a tax code from the Usual Tax Code (optional) drop-down list.

Click the drop-down 
arrow to choose from a 
list of tax codes to apply.
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5.	 Click OK.

Setting up an item to handle GST

You can assign a tax code to an existing invoice item or assign it whilst creating an invoice item.

Assigning a tax code to an existing invoice item

1.	 Go to the Business menu, click Invoices and Estimates, and then click Invoice Items.

The Customise Invoice Items window opens.

2.	 Select an invoice item and click Edit.
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This is 
where you 
can select a 
tax code to 
apply.

3.	 Select a tax code from the Tax drop-down list.

Your selection will override any tax code included as part of a category, if selected from the Category/Tag drop-
down list.

When you select a tax code for an item, the rate you enter in the Rate field must exclude tax. When you create 
an invoice, Home & Business will calculate the required tax based on the item rate. For example, if your item 
rate is $50 and your tax code is GST, Home & Business will add $5 to the invoice as the corresponding tax 
amount.

Assigning a tax code when creating an invoice item

1.	 Go to the Business menu, click Invoice and Estimates and then click Invoice Items.

The Customise Invoice Items window opens.

Planning for business tax time
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2.	 Click New.

3.	 Enter a name or number for your item in the Item/Name Number field.
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4.	 Select a category from the Category/Tag drop-down list (Optional).

If the category includes a tax code, that tax code will apply to the item unless you select a different tax code from 
the Tax drop-down list on this window.

5.	 Enter a description for your item in the Description field (Optional).

6.	 Enter the rate you wish to charge for your item in the Per Item/Rate field.

For a service, it’s best to enter the rate per hour or day, according to how you charge for your services. You will 
specify the quantity when completing the invoice.

7.	 Select a tax code from the Tax drop-down list.

Your selection will override any tax code included as part of a category.

When you set up an item, you can associate a category with that item. This enables the invoice item 
to inherit the category’s properties. However, the category may include a “usual tax code” as part of its 
properties whilst the invoice item has a conflicting tax code associated. In this case the tax code associated 
with the invoice item will override the tax code inherited from the category.

Setting up an ABN Withholding account

In Australia, if a supplier that you deal with does not have an ABN, you may be required to withhold a percentage of 
the total payment on the supplies for later submission to your local tax office.

You can set up an ABN Withholding account to store the percentage withheld. This account is set up as a liability 
account because it is considered money that you owe to the Australian Tax Office.

Create an ABN Withholding account using the following steps.

Planning for business tax time
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1.	 Go to the Tools menu and click Account List.

2.	 Click Add Account.

The Account Setup window opens.

3.	 Select the Liability radio button and click Next.
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Home & Business displays a window asking you to enter a name for this account.

4.	 Enter “ABN Withholding” in the Name this Account field. Click Next.

Home & Business displays a dialog box that asks you to choose the currency of this account.

5.	 Follow the onscreen instructions and complete the setup wizard until you reach the window that asks you to: 
Enter the ending date and balance from your statement, if you have it.

Planning for business tax time
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6.	 Click Tax, and choose the BAS Report: W4 tax line from the Transfers In drop-down list.

7.	 Click OK.

8.	 Click Done.

9.	 Click No if Home & Business offers the option of setting up and associating an amortised loan with this newly 
created account.

Everyday tax transactions
By now you should have:

•	 Activated tax tracking in the business accounts that you will be using to record transactions with a tax amount

•	 Applied tax codes to selected categories and items

•	 Created an ABN Withholding account

Home & Business is now ready to track the GST liability on your everyday transactions such as purchasing goods for 
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your business, selling items to customers and receiving payments.

Whilst most of these tasks are covered in earlier chapters, there are extra steps you need to follow so that Home & 
Business can track tax. These extra steps are part of the following procedures:

•	 Using the Split Transaction window

•	 Entering purchases

•	 Recording amounts for ABN withholding

•	 Using categories with tax codes assigned

•	 Recording payments to or from your local tax office

Using the Split Transaction window

Remember in Chapter 4 how we learnt that you can assign multiple categories to a payment transaction? Home & 
Business enables you to do this with the Split Transaction window. It’s a great way to see a single transaction in 
more detail. It’s also the way to track the GST component of a transaction, as you may remember from entering a 
purchase.

You can get Home & Business to open the Split Transaction window automatically after entering a name and 
amount when you click the Category field of a transaction whilst in an account set up for tax tracking. Go to the 
Edit menu, click Preferences, then click Program. Click Register and select the Automatically enter split data 
check box. Then Click OK.

In addition to the features described in Chapter 4, there are a number of tax-related options you need to know 
about in the Split Transaction window:

•	 Amts include tax check box

Planning for business tax time
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•	 Clear Amts button

•	 Adjust button

Amts include 
tax check box

Clear Amts 
button

Adjust button
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Amts include tax check box

The Amts include tax check box enables you to specify whether the amount you enter on the transaction line is 
inclusive of the tax amount or exclusive of the tax amount.

1.	 Select the check box for Home & Business to treat the entered amount as a gross amount that includes the tax.

For example, if you enter $50 and apply the GST tax code, Home & Business will change the Amount to $45.45 
and enter $4.55 in the Tax column. The Split Total for that transaction line will remain at $50.

2.	 Clear the check box for Home & Business to treat the entered amount as a net amount and the basis to calculate 
and add the amount to the transaction line.

For example, if you enter $50 and apply the GST tax code, Home & Business adds $5 to the Tax column so that 
the split total for the transaction line is $55.

Clear Amts button

The Clear Amts button enables you to remove the amounts from each split line on a chosen transaction. This 
feature comes in handy when you need to modify a transaction that Home & Business has auto-filled from a 
memorised transaction.

To clear all amounts from the split lines of a transaction:

1.	 Make sure you are in the Split Transaction window with the transaction showing.

2.	 Click Clear Amts.

Home & Business clears the amounts and tax codes from the split lines.

If there is any amount remaining, click Adjust.
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Adjust button

You may need the Adjust button when there is an amount left over, that is, when the split total displays a different 
total to the sum of all split line amounts.

To refresh the calculation, click Adjust on the Split Transaction window.

Entering purchases

When you buy goods for your business, you will need to enter the value of the goods in the appropriate register as a 
purchase. The following steps include selecting a tax code through the Split Transaction window.

1.	 Go to the Tools menu and click Account List, then identify the bank account in which you wish to carry out a 
transaction.

2.	 Double-click the account you identified.

3.	 Move to the next available transaction line in the register, changing the date if necessary.

4.	 (Cheques only) In the Num column, enter the cheque number.

5.	 In the Payee column, type the name of the payee.

6.	 In the Payment column, enter an amount.

7.	 Click Split.

The Split Transaction window opens.
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8.	 Select a category from the Category drop-down list and then press the Tab key.

9.	 Select a tag from the Tag drop-down list and then press the Tab key.

Planning for business tax time
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10.	Enter a memo in the Memo column and then press the Tab key. (Optional)

If a tax code applies to the category, Home & Business will populate the transaction line’s “T” column with the 
applicable tax code.

Otherwise you will have to manually select the tax code from the T drop-down list and then press the Tab key, so 
that Home & Business can calculate the relevant tax.

Home & Business calculates the tax amount in line with the selection you have for the Amts include tax check 
box. See “Amts include tax check box” on page 139 for more details.

11.	Click OK.

Home & Business enters the details of your split transaction into the account’s register.

Using categories with tax codes assigned

Earlier in this chapter we looked at how you can attach a tax code to the properties of a category. Thus, when 
entering purchases, Home & Business would assign a tax code to the transaction automatically as part of applying 
the category. Let’s see how this works.

1.	 Open the register for an account that you use to enter purchases.

2.	 Enter the following:

▪▪ Number (Optional)

▪▪ Payee

▪▪ Payment

3.	 Click Split.
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The Split Transaction window opens.

If you do not wish Home & Business to calculate the tax amount automatically using the amount you enter 
as gross (tax inclusive amount), clear the Amts incl tax check box at the base of the Split Transaction 
window.

4.	 Select a category from the drop-down list in the Category column.

5.	 Press the Tab key and enter a memo for the transaction if you have not already entered one (Optional).

Home & Business calculates the relevant tax information based on the category chosen once you press the Tab 
key.

6.	 Check to see that the Split Total equals the total of the amount and tax for that split line. If it doesn’t, click 
Adjust.

Note that if you have the Amts incl tax check box ticked, Home & Business will change the amount you entered 
to be the non-GST element.

7.	 Click OK.

8.	 Click Enter to record the transaction.

The *Tax Control* account will now reflect a decrease in GST liability for the transaction above.

Recording amounts for ABN Withholding

You may need to purchase items from a supplier who hasn’t got an ABN. In most circumstances, the government 
requires that you pay the supplier the value for services provided, minus a percentage deemed by the government. 
This percentage of cost is then to be stored by you and remitted to the ATO at the relevant reporting period. The 
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following steps show how to do this in Home & Business.

Warning: Before following this procedure, you need to have set up an ABN Withholding account, as shown 
on page 133.

1.	 Enter a purchase as normal and open the Split Transaction window.

2.	 Create a second split line and enter the percentage of the purchase amount as a negative amount.

For example: if the percentage is 48.5%, an $800 purchase would mean entering $800 in the first split line and 
-$388 in the second split line.

3.	 Select Transfer From/To [ABN Withholding] from the category drop-down list for the second split line.
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4.	 Click OK.

Do not select a tax code for the split lines as the tax amount in this transaction is actually the negative 
amount you are transferring to the ABN withholding account.

The total amount payable to the supplier should be the amount of the purchase minus the percentage of 
that amount.

Creating a tax invoice

Chapter 8 shows you how to create an invoice. You need to follow the same steps when creating an invoice that 
includes GST. However there are a number of points to remember:
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•	 You can have GST included in a line item by default when the invoice item you choose includes a tax code in its 
properties.

•	 You can also have GST included on a line item by default against an item by applying a category that includes 
tax, if you don’t have a tax code as part of an invoice item’s properties.

•	 You can apply a tax code to an item on a transaction line by selecting it from the drop-down list provided in the 
T column. This approach overrides any default tax code settings from a category or invoice item.

See the instructions on page 155 for details on how to create an invoice.

Using invoice items with tax codes assigned

Using invoice items to apply relevant tax codes and category properties is a great way to save time when creating 
an invoice.

We know that to create an invoice one needs to enter the following information on the invoice line:

•	 Item

•	 Category

•	 Description

•	 Quantity

•	 Rate

•	 Amount

•	 Tax Code

With your invoice item set up to include name, category, description, rate and tax code, you can make four entries 
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simply by selecting an item. Next enter the item’s quantity and Home & Business will do the rest.

You need to choose an item in the following steps that has a category and tax code assigned to it, as 
shown in “Setting up an item to handle GST” on page 130.

1.	 Create an invoice and enter customer details and invoice information (invoice numbers etc.).

2.	 Select an item from the Item column on an invoice line.

Home & Business populates the Item, Category, Description, and Rate fields.

3.	 Enter a quantity in the Quantity column.

Home & Business calculates the amount and the tax amount.

4.	 Enter another item and quantity as above, as required. (Optional)

5.	 Print and/or save the invoice using the Print and/or Save and Done buttons on the right of the Home & Business 
invoice form.

Recording payments to or from your local tax office

Recording payments to your local tax office

At some stage you will have to send a cheque to your local tax office to cover your tax liability.

When this happens, you need to record the cheque payment in Home & Business so that it can accurately reflect 
your tax liability and the account from which you paid the cheque.

This is done by entering the tax amount from the account you are paying the cheque from and transferring it to 
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your *Tax Control* account.

1.	 Open your current account register.

2.	 Click Transfer.

The Record a Transfer between Accounts window opens.

3.	 Select *Tax Control* from the To Account drop-down list.

4.	 In the Memo field, enter a description, such as “payment to tax office”.
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5.	 Enter the amount.

For this exercise, this should be the amount showing up as owing to your local tax office in your *Tax Control* 
account.

6.	 Click OK.

The amount in your *Tax Control* account should now show up as $0.00.
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The amount you 
transferred should 
show up in the *Tax 
Control* account.

In this case, the total 
shows up as $0.00.

Receiving payments from the ATO

When you receive a refund for the GST you have paid, make sure you record it in Home & Business. This is done by 
creating a transfer from the *Tax Control* account to your current account.

1.	 Open the *Tax Control* account register.
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2.	 Click Transfer.

The Transfer window opens.

3.	 Select your current account from the To Account drop-down list.

Your current account is the account that you receive the tax payment into. This could be a savings or business 
account.

4.	 Enter a description in the Memo field, such as “Refund from ATO”

5.	 Enter the amount you are receiving.
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6.	 Click OK.

The amount in your *Tax Control* account should now show up as $0.00.

The amount you 
transferred should 
show up in the *Tax 
Control* account.

In this case, the total 
shows up as $0.00.
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PERFORMING EVERYDAY BUSINESS TASKS

8
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Receiving refunds from suppliers 170

Recording mileage 172

You’ve just looked at recording personal, everyday activities in Home & Business. Now it’s time 
to look at how you can record everyday business activities. 
This chapter shows you how to create estimates and invoices, record payments received from 
customers and paid to suppliers, issue refunds to customers or receive refunds from suppliers, 
and how to record other business-related activities.
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Before you start

Think about the sales and purchases you make as part of your business each day.

This chapter discusses how to record these activities in Home & Business.

Everyday business tasks in Home & Business
Running your business finances is an everyday task like your personal finances - it never stops. At any time, you 
could be preparing estimates or invoices, receiving customer payments, or paying bills from suppliers. Each month, 
quarter, or year, you will have to complete a BAS. It’s important to record all of these activities in Home & Business.

You may not be in a position to record your money movements each day in Home & Business, but it’s a good idea to 
track your everyday money movement regularly in this program. Then you’ll be able to evaluate how effectively you 
are managing your finances.

This chapter looks at the basics of recording those everyday financial activities in Home & Business. We’ll look at the 
different types of accounts you can set up and how you can enter transactions and categorise them to help you 
understand what you spend your money on.
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Creating an estimate or invoice
Although Home & Business uses the cash-basis accounting system, it still enables you to create estimates and 
invoices. There are times when a business that uses a cash-basis accounting system will need to provide clients with 
invoices in order to be paid, particularly when a client is a large company. For example, a musician may play a gig for 
a company’s Christmas party, or a home-based graphic designer may be hired to create a logo for a small company 
that requires tax invoices before processing payments.

Once you receive payment for an item or service, you need to enter it directly into the relevant account’s register. 
This is a separate process to creating an invoice that is necessary for your financial bookkeeping. Therefore, it’s 
important to remember that the process of creating an estimate or invoice is quite different to receiving payment 
from a customer, even if that payment is in response to an invoice.

To create an invoice or estimate:

1.	 Go to the Business menu, click Invoices and Estimates, and then click Create Invoice/Estimate.

The Invoice/Estimate window opens.
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You can 
include 
personalised 
messages 
to your 
customers.

This is where 
you choose 
the template 
for an invoice 
or estimate.

You can print or email an estimate or 
invoice by clicking these buttons.

You can mark 
an invoice as 
“Paid”.
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This is a form where you enter your information. It will look slightly different when you print or email it to your 
clients.

When you open this window for the first time, the form shown by default is an invoice. However, we’d like to start 
with an estimate.

2.	 In the Layout drop-down list, click Estimate Default.

Notice that the window changes slightly, and the Ship To box disappears. This is an estimate form, so there is no 
point to including shipping information.

3.	 In the Customer field, enter the name of a customer, then press the Tab key.

Performing everyday business tasks
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For example, enter “Reckon Ltd”.

When you press the Tab key, the cursor moves to the Bill To box, automatically displaying the name you just 
entered.

4.	 Enter the address in the Bill To box below the company name, then press the Tab key.

For example, enter “65 Berry Street, North Sydney, NSW 2060”.

5.	 Enter a description for your service or item in the Item field, the press the Tab key.

For example, enter “Christmas Party Gig”.

When you press the Tab key, a dialog box opens, asking if you want to create a new item with the name you just 
entered.

6.	 Click Yes.

The New Item window opens.
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7.	 Enter information for the item you have just created and then click OK.

You may choose to include or not include a category. Follow the onscreen instructions.

8.	 Choose a customer message from the Customer Message drop-down list. 

Your estimate should look similar to the following. (Optional)
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9.	 Click Save and Done.

Home & Business replaces the Invoice/Estimate window with the Invoice/Estimate List. The estimate you just 
created should appear on the list.

Now, let’s imagine that your customer accepted the estimate and booked the service or purchased the item. We 
can change the template so that the estimate appears as an invoice.

10.	In the Invoice/Estimate List, double-click the estimate you just created.
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The Invoice/Estimate window opens, displaying your estimate.

11.	Click the Layout drop-down list, and then click Invoice Default.

Notice that the form changes to an invoice layout, including a Ship To box.

12.	In the Ship To box, enter the shipping details.

Your invoice should look similar to the following.

Performing everyday business tasks
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13.	Click Print to print a copy of the invoice.

You can also email the invoice. Refer to the online Help for more information.

You can also include tax calculations in your invoices.

14.	Click Save and Done.

The Invoice/Estimate window closes, and the Invoice/Estimate List window is displayed. The invoice you just 
created should appear on the list.

Click in the 
Paid column 
to mark an 
invoice as 
paid.

Tick Show paid option to display Invoices/Estimates 
that are marked as paid and unpaid. 

Unticking the option will filter the list so that only the 
Invoices/Estimates that haven’t been marked as paid 
will appear as well as appear on the print-out when you 
prints the list.
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When payment for an invoice is received, you can mark the invoice as paid in either of two ways.

To mark an invoice as paid:

1.	 Go to the Business menu, click Business Lists, and then click Invoice/Estimate List.

The Invoice/Estimate List window opens.

2.	 Locate the invoice in the list and double-click it.

The Invoice/Estimate window opens, displaying the invoice.

3.	 Click the Paid check box.

4.	 Click Save and Done

The Invoice/Estimate window closes and the Invoice/Estimate List window is displayed.

5.	 Confirm that the invoice is marked as Paid in the Invoice/Estimate List.

or

1.	 Go to the Business menu, click Business Lists, and then click Invoice/Estimate List.

The Invoice/Estimate List window opens.

2.	 Locate the invoice in the list.

3.	 Confirm that the invoice number in the Doc. # column is the one you want

4.	 Confirm that the number in the Amount column is correct

5.	 Click the corresponding cell in the Paid column.

When you open the invoice again, the Paid check box will be ticked.
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In the Invoice/Estimate List window, you can mark more than one invoice as paid. This can save you time 
when you have multiple invoices to mark.

Recording payments from customers
When receiving a customer payment, be sure to record the payment information in Home & Business. Record this in 
the account you set up specifically to track income and expenses for your business.

To record a customer payment:

1.	 Go to the Business menu, click Customers, and then click Receive Customer Payment.

The Choose Payment Account window opens.

Choose the account that you use to record payments into your business. Generally, this will be a business 
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chequing or savings account.

2.	 In the Account drop-down list, click your business account.

The account register opens, ready for you to enter the payment.

3.	 Enter the transaction, identifying the date, payee and category.

Make sure you enter the payment in the Deposit column. The Payment column indicates payments you make, 
not payments you receive.

4.	 Click Enter.

You can also record tax amounts, providing your account is enabled to track tax. This is possible through 
the Split Transaction window (available in the transaction register by clicking the Split button).

Issuing refunds
It’s sometimes necessary to issue refunds to customers or clients. Be sure to track such transactions in Home & 
Business. 

To issue a refund:

1.	 Go to the Business menu, click Customers, and then click Issue a Refund.

The Write Cheques window opens, ready for you to write a cheque to the customer.
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2.	 In the Write cheques from drop-down list, click the account from which you wish to refund the money.

Generally, this will be your business chequing account, which is where you record your business income and 
expenses.

3.	 In the Pay to the Order of field, enter the name of the customer you wish to pay.

For example, enter “Aretha Redding”.

4.	 In the $ field, enter the amount you wish to refund, then press the Tab key.
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For example, enter “55”.

The numeric amount you entered is spelled out in text on the line below.

5.	 Enter an address in the Address field.

Your cheque should look similar to the following.

6.	 In the Category drop-down list, click an appropriate category under the Income type since the refund reduces 
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your business income. Press Tab key to continue.

7.	 Click Record Cheque.

Paying suppliers
When paying a supplier, be sure to record the information in Home & Business. Record this in the account from 
which the original payment was drawn.

To make a payment to a supplier:

1.	 Go to the Business menu, click Bills and Suppliers, and then click Make Payment to Supplier.

The Write Cheques window opens, ready for your to write a cheque to the supplier.

2.	 In the Write cheques from drop-down list, click the account from which you wish to pay the supplier.

Generally, this will be your business chequing account, which is where you record your business income and 
expenses.

3.	 In the Pay to the Order of field, enter the name of the supplier you wish to pay, then press the Tab key.

For example, enter “Dock Five Music School”.

4.	 In the $ field, enter the amount you wish to pay, then press the Tab key.

For example, enter “35”.

The numeric amount you entered is spelled out in text on the line below.

5.	 Enter an address in the Address field, then press the Tab key. 

For example, enter “116 Great South Rd., Dock Five, NSW”.
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6.	 In the Memo field, enter a memo, then press the Tab key. (Optional)

7.	 In the Category drop-down list, click an appropriate category, then press the Tab key.

Your cheque should look similar to the following.

8.	 Click Record Cheque.

The cheque will appear in the list of cheques to print.
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9.	 Close the Write Cheques window, then go to the Tools menu and click Account List

The Account List window opens.

10.	Locate your business chequing or savings account (from which you drew money after recording cheques) and 
double-click it.

The account opens.

You should see the amount recorded on each cheque in the transaction lines of the account, as shown below.

Receiving refunds from suppliers
When receiving a refund from a supplier, be sure to record the information in Home & Business. Record this in the 
account from which the original payment was drawn.

To record receipt of a refund from a supplier:

1.	 Go to the Business menu, click Bills and Suppliers, and then click Receive a Refund.

The Choose Refund Account window opens.
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Choose the account that you use to record payments to your business. Generally, this will be a business 
chequing or savings account.

2.	 In the Account drop-down list, click the account into which you want to deposit the refund.

The account register opens, ready for you to enter the refund.

3.	 Enter the transaction, identifying the date, payee and category.

Make sure you enter the payment in the Deposit column. The Payment column indicates payments you make, 
not payments you receive.

4.	 Click Enter.

You can also record tax amounts, providing your account is enabled to track tax. This is possible through 
the Split Transaction window (available in the transaction register by clicking the Split button.)

Performing everyday business tasks
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Recording mileage
If you use a car to earn business income, you are in a position to deduct related expenses by tracking the kilometres 
your car travels when performing business related tasks. You can track this along with details of the business trips 
using the Mileage Tracker.

The Mileage Tracker allows you to:

•	 Enter several similar trips

If you visit the same customer each week in the same car to the same destination, you can copy a trip and paste 
it into the Mileage Tracker. You can then edit the new trip, if there are any details you need to modify (such as the 
date).

•	 Sort the trips

You can sort the trips you’ve recorded by purpose, destination, vehicle, date and so on. Simply click the column 
header you wish to sort by and see all the related trips together.

•	 Customise the Mileage Tracker

You can get the Mileage Tracker to display only the columns you wish to see. For example, if you only ever use 
one car when driving to your destination, you can remove the Vehicle column.

•	 Record personal trips

Although the Mileage Tracker is designed for business use, you can still track personal trips. Simply fill out the 
details of a trip as you normally would, but choose Other for the trip type and then include a note for this in the 
Purpose field.

•	 Print a record

Chapter 8
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You can print a record of your mileage to give your tax preparer. Makes life a lot easier! It’s up to you how you use 
the feature. You can record minimal information or lots of information, depending on what works best for you.

The easiest way to learn about the Vehicle Mileage Tracker is to start using it. Let’s start by entering a new trip.

1.	 Go to the Business menu and click Vehicle Mileage Tracker.

The Vehicle Mileage window opens.

2.	 Enter information in the Vehicle Mileage Tracker fields.

3.	 Enter the trip start and end dates, or select them from the pop-up calendars provided.

Performing everyday business tasks
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4.	 Select a trip type from the drop-down list.

5.	 Enter a purpose for the trip. (Optional)

6.	 Enter a destination for the trip. (Optional)

7.	 Enter the vehicle used. (Optional)

8.	 Enter the odometer reading and total kilometres travelled.

9.	 Enter parking and toll charges, if any. (Optional)

10.	Enter the rate of reimbursement if you are being reimbursed for these kilometres. (Optional)

11.	Click Record Trip.

Once you record details for a trip, Home & Business will store it in the Vehicle Mileage list.

Chapter 8
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DETERMINING YOUR NET WORTH

9
Putting it all together 176

Tracking your home value and associated loan 177

Tracking a vehicle value and associated loan 183

Adding other asset and liability accounts 185

Analysing your personal net worth 186

After recording your everyday financial activities in Reckon Accounts, you can get an excellent 
picture of your financial health.

This chapter shows you how you can see the state of your financial health based on the data 
your have entered into your Reckon Accounts file.
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Before you start

To get a complete picture of your net worth, you should enter into Reckon Accounts all the financial 
information discussed in the previous chapters as they apply to your situation before continuing with 
this chapter. If you have completed the previous chapters, most of your work here is already done.

What you’ll need

You will need information about the purchase price and value of your assets (home, vehicle, and so 
on), as well as information about any loans that might be associated with them.

Putting it all together
Although using Reckon Accounts as described in the previous chapters can bring a great deal of order to your 
finances, you still don’t have the complete picture of your financial situation that Reckon Accounts can offer.

In this chapter, you’ll learn how to use the tools and information in the Property and Debt Centre to track the assets 
(what you own) and liabilities (what you owe) not reflected in your bank balance or stock portfolio.

The more financial information you put in your Reckon Accounts file, the more Reckon Accounts can help you 
understand and improve your overall financial health. When you add asset and liability accounts, you’re increasing 
the power of Reckon Accounts to incorporate all your financial data into a single, clear picture of where you stand 
and where you can go.

In this chapter, you’ll learn how to add the following types of accounts:

•	 An asset account for a home you own or are buying, with an associated liability account if you’re paying a 
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mortgage

•	 An asset account for a vehicle you own or are buying, with an associated liability account if you’re paying off a 
vehicle loan

•	 An asset account for other property you own, such as a stamp collection or a work of art

•	 A liability account for other loans or debt, such as a student loan

Tracking your home value and associated loan
If you own a home, you can use Reckon Accounts to track its value, along with the mortgage that may be associated 
with it. Reckon Accounts calculates the value of your equity, the interest you pay each year, and the remaining loan 
balance.

Reckon Accounts creates both an asset and a liability account when you create a mortgage account. If you have 
the last statement you received for the mortgage account you plan to add, get it now. You can use the statement to 
enter the most recent values, such as balance remaining on the mortgage, while you’re adding your account.

To begin tracking your home value:

1.	 Go to the Property & Debt menu and click Go to Property & Debt Centre.

2.	 In the Property & Debt Accounts snapshot, click Add Account.

3.	 Select House (with or without Mortgage), then click Next.
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4.	 Type the name by which you want to refer to this account in the Name this account field, then click Next.

5.	 Follow the onscreen instructions and click Next to move through the pages. Click the Help button if you need 
more information.
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When you add the account, enter the purchase price and the estimated current market value if you know 
it.

Reckon Accounts enters the purchase price as the Opening Balance and adds an adjustment transaction in 
the House account register to reflect the current market value. This allows you to track your equity.

You can enter additional transactions to keep the equity value current as the home’s value changes over 
time.

If you told Reckon Accounts that you have a mortgage on the house, Reckon Accounts adds two accounts: one 
for the positive value of the house (a House account), and one for the negative value of the loan (a House Loan 
account).

To change any details about your loan:

1.	 Go to the Property & Debt menu and click Loans.

2.	 Select the loan you want to edit.

3.	 Click Edit Loan.

The Edit Loan window opens.

Determining your net worth
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4.	 Enter the required loan information.

5.	 Click Next.

Reckon Accounts opens another Edit Loan window.
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6.	 Enter the required loan information.

7.	 Click Done.

To edit any details about your loan payment:

1.	 Go to the Property & Debt menu and click Loans.

2.	 Select the loan you want to edit.

Determining your net worth
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3.	 Click Edit Payment.

The Edit Loan Payment window opens.

4.	 Enter information about your standard loan payment.
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5.	 Click OK.

To have Reckon Accounts remind you to enter each payment transaction, click Payment Method, select 
Scheduled Transaction, and then enter details on when and how the transaction should be entered.

Tracking a vehicle value and associated loan
The steps for tracking a vehicle’s value and associated loan are almost identical to those for adding a house and 
mortgage account. When you add a vehicle loan account, Reckon Accounts adds both an asset and a liability 
account.

If you have your most recent statement for the vehicle loan, get it now.

To add a vehicle loan account:

1.	 Go to the Property & Debt menu and click Go to Property & Debt Centre.

2.	 In the Property & Debt Accounts snapshot, click Add Account.

Determining your net worth
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3.	 Select Vehicle (with or without Loan) and click Next.

The Account Setup wizard for tracking a vehicle opens.

4.	 Follow the onscreen instructions, clicking Next to move through the pages.

If you told Reckon Accounts that you have a vehicle loan, Reckon Accounts adds two accounts: one for the 
positive value of the vehicle (a vehicle account), and one for the negative value of the loan (a vehicle loan 
account).

Chapter 9
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5.	 Enter the requested information about your vehicle loan. Click the Help button for additional information.

That’s it! You’ve set up Reckon Accounts to track the value of your vehicle and associated loan details.

Adding other asset and liability accounts
You can track the value of anything that you own (asset) or owe (liability) in Reckon Accounts.

Use the same procedures as in previous sections to create any asset or liability account that you want Reckon 

Determining your net worth
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Accounts to include when evaluating your financial situation. If you don’t want to track your assets or liabilities in 
great detail, you can create a single asset or liability account. For each account, enter a total value that you think is a 
good estimate of the total value of your assets or liabilities.

When you create a house or vehicle account, Reckon Accounts prompts you to create the associated 
liability account and loan (if any). Don’t forget to create a liability account and loan for any other assets for 
which you owe money.

Analysing your personal net worth
Now that Reckon Accounts has more information about your finances, you can learn more about the value of your 
net worth.

Using the Financial Overview Centre

The Financial Overview Centre shows changes to your assets and liabilities over time, including cash flow and 
investment accounts. It also shows you the percentage of your finances in each type of account.

To view a summary of your net worth:

1.	 Click the Financial Overview tab at the top of the screen.

The Financial Overview Centre window opens.

2.	 Click the Net Worth tab.
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187

Using the Net Worth report

This report shows your net worth as of a specified date. Reckon Accounts calculates your net worth by adding the 
balances of your chequing, savings, cash, asset, and investment accounts (your assets), and then subtracting that 
total from the balances of your credit or charge card and liability accounts (your liabilities).

To generate a Net Worth report:

1.	 Go to the Reports menu and click Reports & Graphs Centre.

The Reports & Graphs window opens.

2.	 Select Net Worth & Balances from the list

3.	 Click Net Worth
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4.	 In the Report Balance as of field, edit the date as you like. (Optional)

5.	 Click Show Report or Show Graph.

Reckon Accounts displays a report or graph that shows the value of all your assets and liabilities.

If you want to exclude certain information from your net worth report, click the Customise button, make any 
desired changes, and then click Show Report.

For example, if you want a report that excludes non-current assets - such as your home - click Customise and clear 
the asset and liability accounts for your home on the Accounts tab.
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DEVELOPING A LONG-TERM PLAN 

10
Planning your finances 190

Reckon Accounts enables you to plan your financial future. You can do this based on existing 
data or use sophisticated calculators to plan scenarios to help you make the right decision. 
This chapter looks at developing a long-term plan for personal finances. This includes 
budgeting, reducing debt, and planning for future loans or savings.
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Before you start

Think about when you would like to retire and what kind of standard of living you anticipate. Consider 
any large purchases you would like to make, and any life changes that you might be facing - such as 
having children or sending them through University.

What you’ll need

If you haven’t already set up the accounts discussed in the previous chapters, you will need information 
such as account balances, the value of what you own and what you owe, and so on.

Planning your finances
The Planning Centre provides tools that help you develop financial plans for things like retirement, University fees, 
home ownership, debt reduction, superannuation or special purchases. In this chapter, we’ll have a quick look at the 
following tools.

•	 Budget

•	 Debt Reduction Planner

•	 Financial Calculators

Creating a budget

You can create a budget in Reckon Accounts to see how much you can afford to spend on different items over 
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time. Apart from creating your real-life budget, you can also create scenarios to see what you can afford in different 
situations.

To access the Budget feature, go to the Planning menu and click Budget.

 You can create a budget in three ways:

•	 Automatic - where Reckon Accounts creates a budget based on the actual income and expenses you’ve 
recorded in your Reckon Accounts file. This is a quick way to get started and helpful to see how your actual 
finances are going. However, missing details in your Reckon Accounts file will show up when you create a first 
budget this way.

•	 Manual - where you enter your information manually into an empty budget that Reckon Accounts creates. 
Details in this form are exactly what you enter, and do not relate to existing data in your Reckon Accounts file. 
This is a good method to use if you have just started a new Reckon Accounts file.

•	 Copy current - where Reckon Accounts copies an existing budget already saved, which you can modify to reflect 
your current circumstances.
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When you open the Budget feature, you’ll be able to choose one of these methods of creating a budget from the 
Setup tab. Follow the onscreen instructions as you work your way through the Budget wizard.
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Using the Debt Reduction Planner

Have a debt you want to get rid of? You need a good plan. You’ll get a great start by using the Debt Reduction 
Planner.

The Debt Reduction Planner wizard guides you through the process of setting up a plan to reduce your debt. It 
asks you questions about how much you owe, pay as interest, receive as income and so on. You’ll develop a picture 
of how you can best pay off your debts - long term or short term. As you continue to make selections in the wizard 
that best fit your personal lifestyle, Reckon Accounts will conclude with a personal, detailed debt reduction plan.

To access the Debt Reduction Planner, go to the Planning menu and click Debt Reduction Planner. Then, follow 
the onscreen instructions.

Developing a long-term plan
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Taking advantage of financial calculators

Reckon Accounts provides the following planner and financial calculators:

•	 Budget Planner

You can work out where your money is going and how you can save more by spending less with Money Smart 
Budget Planner.

•	 Retirement Planner

You can plan how much income you are likely to have after you retire, and what you can do now to boost your 
super with Money Smart Retirement Planner.

•	 Loan Calculator

You can work out how much a loan will cost before you apply.

•	 Refinance Calculator

You can explore the options of refinancing your current home loan.

•	 Savings Calculator

You can get a quick approximation of how much you can save.

•	 University Calculator

You can work out how much you need to put away for a University fund for your child. You can work out what 
you need to put away regularly to meet a particular amount. You can also work out how much you’ll have if you 
make a regular contribution.
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•	 Retirement Calculator

You can get a quick approximation of what you need to put away over time in order to have the right amount of 
money when you retire.

•	 Credit Card Calculator

You can check how long it may take you to pay off your credit card debt with Money Smart Credit Card 
Calculator.

•	 Managed Funds Calculator

You can test or model how your choices may affect the future value of your investments with Money Smart 
Managed Funds Calculator. 

•	 Superannuation Calculator

You can test or model how your choices may affect your superannuation over the long-term with the Money 
Smart Superannuation Calculator.

•	 Super vs Mortgage Calculator

You can work out if you will be better off putting spare money into your super or your mortgage with Money 
Smart Super vs Motgage calculator.

These calculators are designed to give you quick approximations for the different circumstances that they service. 
They’re great as a starter when you’re considering how to handle your finances before taking the plunge of a loan, 
or after taking a loan and discovering where you can tighten your financial management.

Developing a long-term plan
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SOLVING PROBLEMS AND GETTING 
PRODUCT SUPPORT 11
Technical support options and Reckon services 198

Talking to a technical support representative 199

Contacting Reckon 202

If you can’t solve a problem you’re experiencing with Reckon Accounts Personal Plus or Home 
& Business, you can get help from Reckon’s technical support team by telephone, fax or email. 
Reckon also provides a website with a database of support articles (Knowledge Browser), as 
well as a directory of Reckon Accredited Professional Partners.
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Technical support options and Reckon services

Reckon Advantage

Reckon Advantage membership entitles you to free weekday technical and installation phone support, product 
upgrades and special offers. Terms and conditions apply. For more information, visit www.reckon.com.

Fee-based services

Reckon offers a number of support plans to meet your individual needs.

Timed Call Support: A one-off support call that is charged by the minute. Maybe you don’t have twenty four hours 
to solve your problem but need to speak with one of our specialists right away? For instant help during business 
hours, ring our telephone support service for the advice you need.

Data Recovery: If your Reckon Accounts data file becomes damaged, we can provide data recovery service, which is 
available for a fee.

Password removal: If you forget your Reckon Accounts file password, we can remove your password so you can 
access your important data, a service that is also available for a fee.

Reckon’s website

The Reckon website, (www.reckon.com), provides answers to many Reckon Accounts questions, important product 
updates, and access to help through the Knowledge Browser, an online technical support database.

If you’re connected to the Internet, you can access the Reckon website directly from the Help menu in Reckon 
Accounts.
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Reckon Accredited Professional Partners

Developing a strong, knowledgeable network of professionals is an important part of our commitment to delivering 
exceptional support to our Reckon Accounts customers. Whatever your individual needs may be, Reckon has an 
expert to help.

The Reckon Accredited Professional Partners referral service is free. The professional you select will provide you with 
information about their fees.

If you are an accountant, bookkeeper, or computer consultant, consider becoming a member of this unique 
community. To find a Reckon Accredited Professional Partner, or to become one yourself, visit the Reckon website. 
Details for contacting Reckon are provided below.

Talking to a technical support representative

Be prepared when you call

If you need to call for assistance, you will get an answer quicker if you:

•	 Make sure you have registered your copy of Reckon Accounts and have your registration details and customer ID 
number ready. (It’s a good idea to have written this down in the front of this User Guide following registration.) 
To display your licence number, go to the Help menu and click Licence Information.

•	 Are at your computer with Reckon Accounts running.

•	 Try to remember the windows you opened and the tasks you carried out before encountering the problem. 
Know the exact wording of any message that appeared in the window(s).

•	 Have a pencil and paper handy to take notes.
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•	 Have the following information ready when you call:

▪▪ Model of computer and amount of memory (RAM) and hard disk space

▪▪ Accessory manufacturer, type and model (for example, monitor or printer)

▪▪ Operating system version

▪▪ Network configuration and software version

Solving problems on your own

We recommend you back up your Reckon Accounts data file before you start. See “Backing up your Reckon 
Accounts data file” on page 24 for more information.

Guidelines for solving typical problems

Use the following examples as a guide to solve the problems you have.

Try the procedure again

Start at the beginning. Examine windows where you filled in fields to be sure you are asking the program for what 
you want.

Try a related procedure

For example, if you have a printing problem:
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•	 Ensure the printer is working by trying to print something else. If you have trouble printing cheques, try printing 
a report. If you can’t print one of the sales forms, try printing a similar form.

•	 If you can’t print from Reckon Accounts, try printing from another program such as Microsoft Notepad. If nothing 
prints from Notepad, you know the problem is likely to be related to the printer, not the software. Check the 
printer connections, printer driver, print queue and so forth.

Think about what has been changed

If something used to work but no longer does, think about what may have changed.

•	 Have you changed or added other programs on your computer?

•	 Have you added a new printer?

•	 Have you moved the Reckon Accounts data file to a new location?

•	 Have you changed a setting in the Preferences window?

If the program “hangs” or locks up

There are a number of reasons why your system may freeze while using Reckon Accounts. Try restarting your 
computer. If restarting doesn’t help, go through the following questions and take any related action:

•	 Does your computer system or network meet the minimum requirements necessary for Reckon Accounts, as 
outlined in the Reckon Accounts Installation and Upgrade Guide? (A copy of the Guide is included on your 
Reckon Accounts  DVD. The most recent version, including any last-minute changes or updates, is available on 
the Reckon website.)

•	 Are you making the best use of available system resources by shutting down other programs that are running? 
(Check for programs that may be running in the background without your knowledge.)

Solving problems and getting product support
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•	 Do you have enough hard disk space available? 

•	 Do you have any conflicts with sound or video drivers?

If you experience system freezes while using Reckon Accounts, you may want to call for technical support.

Contacting Reckon

Australia
Product Activation Products can be activation online 24 hours a day, 

or by telephone during business hours.
If you can’t activate your product using onscreen 
instructions after going to the Help menu, then 
clicking Register Reckon Accounts, call: 1300 650 
061

Product Re-activiation You can re-activation your program through this 
service.

Re-activation is capped at $9. (Charges include 
GST and only apply once you are connected to a 
representative.

Call: 
1902 266 522
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Australia
Customer Service and 
Reckon Sales

For pre-sale, product-specific information, to 
purchase an upgrade, for order inquiries, or 
information on Reckon Advantage and so on.

Call: 
1300 784 253

Email: 
customerservice@reckon.com

Fax: 
02 9577 5557

General Product Information For general product information and FAQs. Visit: 
http://www.reckon.com

Technical Support Call cost $4.90/min

(Charges include GST and only commence 
once you are connected to a technical support 
representative.) Charges are higher from public 
and mobile phones.

Advantage customers receive free technical 
support for the duration of their membership.

Search the Knowledge Browser for answers to 
common questions.

Call: 
1902 223 101

Call costs subject to change. Go to http: //www.
reckon.com.

Refer to your Advantage Welcome Pack for 
information on free Technical Support.

Visit: 
http://www.reckon.com
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Australia
Data Recovery To request data recovery for a damaged Reckon 

Accounts data file.

For more information on data recovery online.

To prevent having to request data recovery, you 
can use Reckon’s online backup service, Reckon 
Backup.

Go to the Data Services website

Visit: 
http://www.reckon.com.

Visit: 
http://www.reckon.com.

Password Retrieval To request a forgotten password be removed from 
your file.

http://www.reckon.com.

Reckon Stationery Reckon offers a range of stationery that works 
with your Reckon software.

Cheques, invoices, pay slips and more – Reckon 
stationery helps deliver the most from your 
accounting software!

Call: 
1300 301 166

Fax: 
1300 131 972

Update your details Keep your details current so we can keep you up 
to date on product developments and important 
software changes.

Update your details online at  
http://www.reckon.com.

Postal Address Reckon postal address to send software orders as 
well as any other written correspondence.

Reckon Limited 
Locked Bag 7522 
McMahons Point 
NSW 2060

Website address www.reckon.com
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New Zealand
Product Registration Call: 

0800 933 606 (from within New Zealand) 
+64 9 489 9440 (from abroad)

Customer Service Call: 
0800 477 292

Email: 
presales@reckon.co.nz

Visit: 
http://www.reckon.co.nz

Technical Support Call: 
0800 933 666 (attracts a per-incident charge) 
0900 33 609 (attracts a per-minute charge) 
Charges are higher from public and mobile phones.

Visit: 
http://www.reckon.co.nz
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LICENCE AGREEMENT

THIS IS AN IMPORTANT DOCUMENT.  PLEASE READ THIS CAREFULLY. 

This is a contract between Reckon Limited (ACN 003 348 730) (Reckon) and you.  By using the Software supplied with this document, and the related 
user guides and materials (together the Software), you agree to be bound by the terms of this Licence and the application of Reckon’s Privacy Policy 
www.reckon.com to information collected from you. The Privacy Policy can also be viewed on the website. This Licence covers copies of the Software 
provided for evaluation or trial purposes, subscription versions and non-subscription or full versions of the Software. Some Licence provisions may not be 
applicable to you, depending on the particular version of the Software you have purchased or if you are using the Software for evaluation purposes.  The 
defined terms and the rules of interpretation in this Licence are set out in clause 14.

Important:  Please refer to the website for details of the Software, minimum requirements and functionality. Please also refer to Reckon’s Privacy Policy 
at www.reckon.com There are a number of technical features within the Software that may affect your ability to continue to use the Software.  These are 
outlined in more detail in the terms of the Licence, but in summary:

•• You are purchasing the right to use the Software, not to own it;

•• If you have been provided with a Trial Version, you may only use the Software on a temporary basis to evaluate the Software’s functionality and 
suitability for your requirements;

•• The Software contains registration and activation processes to guard against illegal copying; 

•• To continue using the Software, those processes require you to verify your compliance with the terms under which you are licensed to use the 
software (for example: the number of computers on which the software is installed) and to permit continued reactivation of the Software from time 
to time.  This involves, in all versions, periodically verifying your licence details, and in the subscription version, renewing your subscription when 
it falls due. Reckon may also verify subscription customers during a subscription period and not only at renewal. You will also need to reactivate 
your Software if you want to reinstall it (for example, if you upgrade your computer or if you have a hard drive failure, and you may incur a technical 
support cost for this);

•• When you purchase the Software or during the course of your subscription you will be provided with an installation key code (“IKC”) for your 
exclusive use in accordance with the terms of this licence.  Please keep the installation key code in a safe place.  You may need it when you first 
install or re-install (if permitted) the Software and to reactivate the Software. Please note if you lose your installation key code that it will not be 
replaced by Reckon and you will not be able to install or reactivate the Software;

•• You also need a licence key to reactivate your Software.  In addition, with some older versions of the Software, you will not be able to re-install or 
reactivate the Software if you do not have your installation key code - see details below on Reckon’s sunset policy;

Licence Agreement
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•• There will be no charge to activate the Software initially or to reactivate your Software when you verify your licence details or renew a subscription, 
Reckon may charge you a fee for technical support if it needs to reissue a licence key provided also that the version of the Software you are using 
has not been ‘sunsetted’ as explained below. Reckon may also charge a fee if you need to reactivate the Software in other circumstances (for 
example, if you need to reinstall the Software if you upgrade your computer or due to a hard drive failure); 

•• If you do not renew your subscription, which also requires you to install and use the updated Software or if you do not verify your licence details (as 
applicable) within the required period, the Software may continue to operate but with impaired functionality or you may not be able to access the 
Software at all (including printing out or viewing any of your data or records); and

•• Reckon has a ‘sunset policy’ which means that technical support is not available for some older versions of the Software.  This includes the ability to 
install or re-install that Software for any reason if you have lost your installation key code for those old versions. If you wish to continue using the 
Software in those circumstances, you will need to purchase a new copy of the current version of that Software.

•• Data Collection & Privacy: You acknowledge that Reckon collects information from you when registering, activating and validating the Software 
and when you use the Software. For details on how we collect, use, disclose and store your personal information and how you can contact us if you 
want to access or correct personal information, please refer to Reckon’s Privacy Policy on our website www.reckon.com. By activating and using the 
Software you consent to Reckon’s collection and use of the information collected from you in accordance with Reckon’s Privacy Policy

•• Use of Software is not provision of tax, accounting or other professional advice: 

(a)	 The information contained in the Software may contain features designed to assist you in complying with the requirements of relevant 
legislation. 

(b)	 In providing you with information which may relate to relevant legislation, Reckon is not engaged in rendering legal, accounting or other 
professional services and that nothing in the Software constitutes taxation, financial, wealth management, superannuation or other professional 
advice. Legal, accounting or other relevant professional advice should be obtained before taking any action in reliance on this Software.

(c)	 While relevant reports produced using the Software will be compliant with legal requirements at time of release, as these requirements may 
change from time to time, you should confirm compliance with your tax, accountant or professional adviser before relying on any such reports.

(d)	 The help contained in this Software is not a substitute for obtaining the appropriate independent professional advice. If legal advice or other 
expert assistance is required, you should seek the service of the appropriate competent professional.

•• Third Party Online Services: The Services may contain access to, or features that interface with, third party online services (“Third Party Online 
Services”). Where Third Party Online Services are available, separate terms and conditions with the provider of the Third Party Online Services may 
apply and access to the Third Party Online Services may be terminated if you do not pay the required charges. Charges may apply for the use of 
Third Party Online Services including the cost of internet access. Except as required by the Consumer Guarantees, access to Third Party Online 
Services may be withdrawn by Reckon at any time. Reckon does not make any recommendations in relation to the Third Party Online Services 
or accept any liability or responsibility for any loss or damage relating to the Third Party Online Services except as required by the Consumer 
Guarantees. 
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•• Back up & Data Retention: Your should ensure you conduct regular backups of your data. Except as required by the Consumer Guarantees,  Reckon 
on behalf of itself and/or any of its distributors and associates, does not assume any liability with regard to your use of the Software, including but 
not limited to, loss of data. In addition, you should confirm your data retention requirements for tax and compliance purposes with your professional 
adviser.

•• Liability: To the maximum extent permitted by any law, including the Competition and Consumer Act 2010 (Cth) Consumer Guarantees, Reckon will 
not be liable responsible for delays, non-performance, failure to perform, processing errors nor will the liability of Reckon include or extend to any 
special or consequential loss or damage suffered by you, except where required by the Consumer Guarantees. 

•• Disclaimer: To the maximum extent permitted by any law, including the Consumer Guarantees, neither Reckon or any provider of Third Party 
Services (“TPS Providers”), including but not limited to any Third Party Online Services including any bank, will be responsible for any data 
submitted, entered or created using the Services or any Third Party Services (for example, including but not limited to bank data feeds), delays, non-
performance, failure to perform, processing errors or any other matter or thing which may be required from any TPS Providers, such as an authority 
or approval, or any agreement with Reckon or any TPS Providers, as the case may be. You are responsible for the accuracy of all data entered; all 
output created by you relying on the data entered; and where relevant, that any data or document lodged is accurate, timely and is compliant with 
all relevant laws and regulations, including keeping the required documentation and records needed to be kept to meet regulatory requirements in 
relation to the information or material lodged and any other data retention or compliance requirements. Nor will the liability of Reckon, or any TPS 
Providers, including but not limited to any bank (whether jointly, severally or jointly and severally) include or extend to any special or consequential 
loss or damage suffered by you, except where required by the Consumer Guarantees.

•• Limitation of implied terms:  In relation to goods or services not ordinarily acquired for personal, domestic or household use, Reckon’s (and its 
distributors’) liability for breach of any guarantees, implied conditions or warranties that cannot be excluded is limited, to the extent permitted by 
law and at the option of Reckon, to repair the goods, or the cost of repairing the goods, to replacing or re-supplying the goods or services or their 
equivalent again or the payment of the cost of having the goods or services or their equivalent replaced or supplied again. You acknowledge that 
this clause, and any reliance on it by Reckon, is fair and reasonable.

•• Reckon’s Contact details: 

Business address: 	 Level 12, 65 Berry Street, North Sydney, NSW 2060

Contact number:		 1300 784 253

Contact email:		  customerservice@reckon.com
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1.  LICENCE

(a)	 Evaluation licence: If Reckon has provided a Trial Version of the Software to you, your rights to use the Trial Version are solely as set out in clause 
12.

(b)	 Licence to use: Reckon grants you a personal, non-exclusive, non-transferable, limited licence to use the Software on the terms of this Licence for 
the period determined in accordance with clause 10.

(c)	 No transfer of copyright: The Software is licensed not sold, despite any reference to “purchase” or “sale” in this Licence or in any invoice or purchase 
order for the supply of the Software.  Reckon reserves all rights not expressly granted to you.  Reckon Limited is the owner of copyright in the 
Software and retains ownership of the copyright and all other intellectual property rights in the Software and is protected by copyright law and 
international copyright treaty.

(d)	 All access to the Software is solely verified by user Login and password;

(e)	 You are entirely responsible for maintaining the confidentiality of all your licence and access details (eg user name and password) and every user 
of your Software including Third Party Online Services, such as bank data feeds;

(f )	 You agree only to grant access to the Services for use by you or on your behalf;

(g)	 You are entirely responsible for the access rights that are granted to any person or other users using your Software, including Third Party Online 
Services. 

(h)	 You are entirely responsible for any and all activities using the Software by any person or persons, including Third Party Online Services, such as 
bank data feeds;

(i)	 You are responsible for the accuracy of all information and authorisations provided to Reckon or any third party service providers, relating to the 
Software or access to any of the Third Party Online Services, for example bank data feeds;

(j)	 Reckon will not be liable for any loss that you may incur as a result of unauthorised use of your Software or any Third Party Online Services, by any 
person or persons; 

(k)	 You may be held responsible for losses incurred by Reckon or any third party due to any unauthorised use of your Software or any Third Party 
Online Services, by any person or persons; and

(l)	 Access to your Account may be restricted by user login and passwords. 

2. YOUR PERMITTED USE OF THE SOFTWARE

(a)	 Single use licence: If you have purchased a single user licence, you:

(i)	 may install the Software once, on one computer only. However, if you wish to reinstall the Software (for example, if you need to install the 
Software on a replacement computer), then clause 3 will apply; and
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(ii)	 must ensure that the Software is used by one person only at any one time. 

(b)	 Additional licences: Subject to any multi-user licence that you have obtained, if:

(i)	 more than one person is to use the Software at the same time; or

(ii)	 the Software is to be installed on more than one computer

then you must obtain an additional licence for each additional person or computer.

(c)	 General restrictions: You must not:

(i)	 use or rely upon the Software for any purpose or in any manner for which the Software is not warranted;

(ii)	 copy, reproduce, translate, adapt, vary, merge or modify or create any derivative work based on the Software;

(iii)	 reverse engineer, decompile, disassemble, reconfigure or otherwise attempt to discover the source code of the Software; or

(iv)	 sell, market, network, transfer, lease, license, sub-license, rent, lend, share  or otherwise dispose of or distribute the Software and/or the 
relevant unique installation key code (“IKC”); or 

(v)	 use the Software to provide any a bureau, hosting or other services by internet or by any other means.

(d)	 Licence verification: Upon written request from Reckon, including by e-mail, you agree to provide Reckon with a signed certificate:

(i)	 verifying that the Software is being used fully in accordance with this Licence, including user and machine limitations; and 

(ii)	 listing locations, types and serial numbers of equipment on which the Software is run.

You agree to allow Reckon to use and disclose any personal details provided to Reckon in connection with this Licence in accordance with 
Reckon’s then current privacy policy displayed on Reckon’s website.

(e)	 Audit rights: Reckon may also audit the number of copies of the Software in use or possession by you, the equipment on which the Software is 
installed or used and the number of users using the Software. Audits will be conducted in your normal business hours, or upon reasonable prior 
written notice, at Reckon’s expense. If the audit reveals underpaid or unpaid fees due to Reckon, you will be invoiced for them based on Reckon’s 
then current price list, and if these exceed 5% of the licence fees you have already paid, you will also be invoiced for the cost of the audit.

3.	 BACK-UP & DATA RETENTION

(a)	 Back up: You should also ensure you conduct regular backups of your data. Except as required by the Consumer Guarantees, Reckon on behalf of 
itself and/or any of its distributors and associates does not assume any liability for loss of data. 

(a)	 Data retention: You are responsible for ensuring you meet all your data retention requirements for tax and any other compliance purposes. 
You should confirm these requirements with your professional adviser, as some legislation requires you to keep copies of certain data for later 
reference, for example, for the ATO or ASIC
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4. PRODUCT ACTIVATION AND VERIFICATION 

(a)	 Initial registration and verifying licence details: This Software may contain technology that protects Reckon against illegal copying. As a 
consequence, you may be required to:

(i)	 register your details during the initial installation (including your name, contact details and details of the hardware on which the Software 
will be installed (if this is not done automatically by the Software);

(ii)	 if you have a full version, have the Software reactivated periodically thereafter by verifying your licence details to confirm you are using the 
Software in accordance with these Licence terms;

(iii)	 if you have a subscription version, have the Software reactivated (on payment of Reckon’s renewal fee and verification of your licence details) 
if you wish to renew the subscription;

(iv)	 have the Software reactivated by Reckon if you wish to re-install the Software (for example, if you would like to install the Software on a new 
computer or if you have a hard drive failure and need to reload your Software); and

(v)	 provide to Reckon the details of your installation key code and product key code for the Software as part of the reactivation process. 

You agree to activate or reactivate the Software within a reasonable time or within such time as the Software prompts you to do so.

(b)	 Key codes: Each copy of the Software is provided with a unique installation key code (“IKC”) (which may appear on the packaging or the cover of 
the media on which the Software is contained).   This IKC is for your exclusive use only in accordance with the terms of this Licence.  You should 
keep the installation key codeIKC safe.   As per clause 4(a)(v), you will be required to provide your installation key code to Reckon when you 
reactivate your Software.  

(c)	 Manner of verification: You must verify your licence details in the manner required by Reckon from time to time (which may include email or on-
line registration via the Internet).  The Software may prompt you as to the required manner of verification.

(d)	 Charges for reactivation: Reckon will not charge you to activate the Software initially or to reactivate your Software when you verify your licence 
details or renew a subscription, unless you have lost your installation or licence key code.  You need both your installation code and your licence 
key to be able to reactivate the Software. Reckon may charge you a fee for technical support to reissue a licence key code.  Reckon may also 
charge a fee for technical support if you need to reactivate the Software in other circumstances (for example, if you need to reinstall the Software 
because you have a new computer or need to reload the Software due to a hard drive failure).  For the current fees go to http://www.reckon.com. 
If you have lost your installation key code, Reckon will not replace that code, and you may be required to purchase new software.

(e)	 Consequences of non-renewal and failure to verify details: This Software is provided to you on the understanding and acknowledgment that it may 
contain technology which deactivates and disables the Software if a subscription is not renewed or in the case of a full licence version, you have 
not verified your licence details when periodically prompted to do so by Reckon or by the Software.  If the Software is not reactivated within 
the required period, the Software may continue to operate but with impaired functionality or you may not be able to access the Software at all 
(including printing out or viewing any of your data or records).
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(f)	 Statutory declaration: In certain circumstances, before permitting a re-activation, Reckon may require you to provide it with a Statutory 
Declaration stating the reasons for re-activation in a form required by Reckon.

(g)	 Older versions: Reckon has a sunset policy (covered in more detail in clause 5(a)) which means that technical support is not available for certain 
older versions of the Software.  If technical support is not available for your version, you will not be able to reactivate or reinstall your Software if 
you do not have your registration key code.  Reckon will not be obliged to provide you with a replacement key code and in those circumstances 
you will need to purchase a new version or Upgrade in order to continue using the Software.  Please go to http://www.reckon.com to see the 
sunset policy. 

5. DATA COLLECTION AND PRIVACY

(a)	 You acknowledge and agree that Reckon collects information from you when registering, activating and validating the Software. Additional 
information may also be collected in relation to your use of the Software. Reckon handles personal information in accordance with the Privacy 
Act 1988 (Cth) and the applicable Privacy Principles. For details on how we collect, use, disclose and store your personal information and how you 
can contact us if you want to access or correct personal information please refer to Reckon’s Privacy Policy on our website www.reckon.com .

(a)	 By activating and using the Software, including technical support:

(i)	 	You you agree to allow Reckon to use and disclose any personal details information provided to Reckon in connection with this Licence in 
accordance with Reckon’s then current privacy policy displayed on Reckon’s website; and.

(ii)	 you acknowledge and agree that you are solely responsible and liable for any personal information you collect, use or store using the 
Software

6. TECHNICAL SUPPORT 

(a)	 Period when technical support is available: Reckon will provide technical support for the Software only (and for the avoidance of doubt this does 
not include support for third party hardware or software, which remains the responsibility of the relevant third party), during the following 
periods: 

(i)	 in the case of a subscription version of the Software, during the period for which you have paid the relevant subscription fees (unless further 
releases of the Software in question are discontinued); and

(ii)	 in the case of a full version of the Software, there is a ‘sunset period’ during which technical support may not be available for that version.  
The sunset period for a version will commence on the earlier of:

(A)	 2 years after the date on which you first installed the version on your computer; or

(B)	 the date Reckon releases the second successive Upgrade to that version.

For further explanation of Reckon’s sunset policy please go to http://www.reckon.com.
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(b)	 What is included as part of technical support: Reckon will provide technical support in accordance with its then current technical support policy, 
which may include::

(i)	 as contemplated by clause 4, the technical support required to reactivate the Software or to issue a replacement  registration key code (for 
example, when you verify your licence details, renew a subscription or if you need to reinstall the Software);

(ii)	 provision of telephone help desk support services;

(iii)	 access to technical information about the Software contained on Reckon’s website; and

(iv)	 the ability for you to download Updates,

but it does not include provision of Upgrades of the Software. For further explanation of Reckon’s technical support policy please go to http://
www.reckon.com. 

(c)	 Fees: Clause 4(d) sets out the circumstances when you will (and when you will not) be required to pay charges for the technical support to 
reactivate your Software (including when you wish to reinstall the Software) or for Reckon to issue a replacement registration key code. 

For all other technical support, Reckon may charge you a fee in accordance with its then current technical support policy.

7. ONLINE SERVICES

(a)	 Interaction with Online Services: The Software may contain access to, or features that interface with, third party online services (“Third Party 
Online Services”).  Examples of Third Party Online Services that may be applicable to the Software are ASIC, EFTPOS, SBR-enabled services, an 
online share price download facility, bank data feeds, and a statement download facility, bill and other payment services, a superannuation 
choice facility, online backup facility, payroll services and a debt recovery facility, technology, hardware or application, which may or may not be 
provided at an additional charge on a subscription basis measured for one year from the date of registration. 

(b)	 Terms for Third Party Online Services:  Certain Third Party Online Services are not available for all versions of the Software. For example, in the 
case of bank statement download services, not all banks provide services that connect to the Software.  Third Party Online Services are only 
available for 12-month periods for subscription versions and 24-month periods for full versions. In the case of a full version, access to Third Party 
Online Services in the second 12-month period may be subject to payment of the applicable charges. In order to renew access to Third Party 
Online Services at the end of the 24-month period in the case of a full version, you will be required to have purchased or upgraded to the latest 
version of the Software. In the case of a subscription version, you must have renewed your subscription.  Internet access is required for all Third 
Party Online Services.  Charges may apply for the use of Third Party Online Services (in addition to the cost of Internet access levied by your ISP).  
Where Third Party Online Services are available, separate terms and conditions with the provider of the Third Party Online Services may apply.  In 
some cases Reckon may be the provider. You should check with the relevant third party provider as to the terms and conditions of use. You are 
responsible for all information and authorisations provided to access and use any such Third Party Online Services and for any data, form or other 
output relying on the use of the Third Party Online Services and/or the Services. In some cases Reckon may be the provider. You should check 
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with the relevant third party provider as to the terms and conditions of use. You are responsible for all information and authorisations provided 
to access and use any such Third Party Online Services and for any data, form or other output relying on the use of the Third Party Online Services 
and/or the Services. Except as may be required by the Consumer Guarantees, access to Third Party Online Services may be withdrawn by Reckon 
at any time.  Reckon will not be liable for the withdrawal of access to any Third Party Online Services.  Where access is to be withdrawn, Reckon 
may choose to notify you in advance provided that you have supplied Reckon with a valid and up to date email address. 

(c)	 In some cases you may download other third party applications, for example Google Desktop supplied by Google Inc. In such cases your 
agreement to be bound by the terms of this Licence will also bind you to the terms of use or other similar agreements required by such third 
parties for use of their products.

8. LIMITED WARRANTY

This clause 8 is subject to the consumer guarantees regime as set out in Schedule 2 to the Competition and  Consumer Act 2010 (Cth) (also referred to 
as the Australian Consumer Law), and the Consumer Guarantees Act 1993 (NZ), as amended from time to time, or other similar legislation of a state or 
territory of Australia or NZ respectively (“Consumer Guarantees”).  

In Australia, our goods come with guarantees that cannot be excluded under the Australian Consumer Law.  You are entitled to a replacement or refund 
for a major failure and compensation for any other reasonably foreseeable loss or damage.  You are also entitled to have the goods repaired or replaced 
if the goods fail to be of acceptable quality and the failure does not amount to a major failure. In New Zealand, these guarantees cannot be modified nor 
excluded by any contract, except in those circumstances contemplated by section 43(2) of the New Zealand Consumer Guarantees Act.

(a)	 Software provided on an ‘as is’ basis:  Except as required by the Consumer Guarantees, Reckon provides the Software to you on an “as is” basis and 
without any representations by Reckon or any of its authorised distributors regarding the use, performance or results of the use, of the Software.

(b)	 Defects in media:  In addition to any rights and remedies you have under the Consumer Guarantees, Reckon warrants that the media on which 
the Software is recorded is free from defects in manufacture for a period of 90 days from the date of delivery (for on-line purchases) or 90 days 
from the date of purchase (for in-store purchases).  During this period, subject to clause 8(c), Reckon will replace any defective media on which 
the Software was supplied and any Software on that media, free of charge, unless you caused damage to the media due to poor handling.

(c)	 To make a claim under clause 8(b), you must:

(i)	 email customerservice@reckon.com with the subject line ‘warranty claim’, and include the following:

(A)	 in the body of the email, provide the IKC, detail the fault and whether a workaround has been provided by a member of Reckon’s 
support team; and

(B)	 	provide a copy of the receipt or proof of purchase and payment.

Once Reckon receives the information, Reckon will provide a preliminary assessment of the claim and contact you to advise.  Software assessed 
on a preliminary basis to be defective by Reckon will be replaced by Reckon and sent to you at Reckon’s cost. 
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(d)	 No guarantee that Software will be error free or that its use will be uninterrupted:  While Reckon has endeavoured to make sure that the Software 
works substantially as per the specifications published by Reckon from time to time, except as required by the Consumer Guarantees, Reckon 
does not guarantee that the Software will work on all computer hardware platforms or configurations and makes no warranty that the Software 
will be error free or that its use will be uninterrupted.

(e)	 Internet access, telecommunications networks, firewalls and security: Except as required by the Consumer Guarantees, Reckon does not 
guarantee connections to its online activation server as these may be dependent upon third party networks and security measures over which 
Reckon has no control. 

9. LIABILITY

(a)	 Certain rights cannot be excluded: Certain laws, including the Consumer Guarantees, may imply certain guarantees, conditions and warranties into 
this Licence or impose certain guarantees, conditions and warranties by law and give you certain rights and remedies that cannot be excluded or 
modified.  This clause 9 and the limited warranties provided in clause 8, do not exclude or modify any of those rights if to do so would contravene 
that law or make any part of this Licence void.

(b)	 Exclusion of warranties: Except as required by the Consumer Guarantees, Reckon excludes all guarantees, conditions, warranties and rights that 
may be implied into this Licence or imposed by law.  If guarantees, conditions, warranties or other rights for your benefit are implied in this 
Licence or otherwise conferred by law and it is not lawful to exclude, restrict or modify them, then those guarantees, conditions, warranties and 
other rights will (but only to the extent required by law) apply to this Licence. 

(c)	 Limitation of implied terms: In relation to goods or services not ordinarily acquired for personal, domestic or household use, Reckon’s (and its 
distributors’) liability for breach of any guarantees, implied conditions or warranties that cannot be excluded is limited, to the extent permitted by 
law and at the option of Reckon, to repair the goods, or the cost of repairing the goods, to replacing or re-supplying the goods or services or their 
equivalent again or the payment of the cost of having the goods or services or their equivalent replaced or supplied again. You acknowledge that 
this clause, and any reliance on it by Reckon, is fair and reasonable.

(d)	 General exclusion and limitation: Other than as set out in clauses 9(b) and 9(c), and as required by the Consumer Guarantees

(i)	 Reckon (and its authorised distributors) will not be liable to you or any other person for any direct or indirect loss, damages, liability, costs or 
expenses suffered by you or any other person relating to the performance or non-performance of the Software or any breach of this Licence 
or the supply of the Software or in connection with, but not limited to, the Third Party Online Services, delays, non-performance, failure to 
perform, processing errors use of tax tables, bank data feeds, use of third party hardware (for example but not limited to Postec services) or 
provision of technical support (whether by telephone or remote access or other means), nor will the liability of Reckon include or extend to 
any special or consequential loss or damage suffered by you, except where required by the Consumer Guarantees; and

(ii)	 Reckon’s maximum liability for damages arising in connection with this Licence or the supply of the Software is limited to the amount paid 
by you for the Software.
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(e)	 Your liability to Reckon: You agree that Reckon (and its authorised distributors) will not be liable, other than as required by the Consumer 
Guarantees or as expressly set out in this Licence, and that you will indemnify the Reckon (and its authorised distributors) from any liability, 
loss, damage, costs or expenses which you may suffer or incur, including any breach of the Privacy Laws, as a result of your use of the Software 
(including any claims made against you by third parties).

(f )	 Use of Software is not provision of professional advice: The information contained in the Software may contain features designed to assist you 
in complying with the requirements of the relevant legislation at the time of the release of the Software, which includes for example, but not 
limited to superannuation guarantee requirements, tax tables, rates for contributions or deductions calculated using the Software. These 
compliance requirements may change from time to time. You agree it is your obligation to ensure the details, calculations, reports and any other 
data or documents produced using the Software, are correct and compliant when created or used by you. Legal, accounting or other relevant 
professional advice should be obtained before taking any action in reliance on the Software or what is produced by you using the Software. The 
Software is also not financial product advice. You acknowledge that Reckon is not engaged in rendering legal, accounting or other professional 
services and nothing in the Software constitutes taxation, financial, wealth management, superannuation or other professional advice in relation 
to these matters. The help contained in the Software is not a substitute for obtaining the appropriate independent professional advice. If legal 
advice or other expert assistance is required, you should seek the service of the appropriate competent professional. 

(g)	 Reckon has no responsibility for recommendations: Except as required by the Consumer Guarantees, Reckon, its employees, agents, contractors and 
the authors disclaim any and all liability and responsibility to any person, whether a user of this Software or not, in respect of anything (including, 
without limitation, any error in or omission from this Software) and of the consequences of any actions taken or omitted to be taken in reliance, 
whether wholly or partially, upon all or any part of the content, recommendations or help contained in this Software.

(h)	 Corruption of Data and on-line access: Except as required by the Consumer Guarantees, Reckon and its authorised distributors disclaim all liability 
for any corruption of data, inability to access data, loss of data, breach of privacy, or downtime as a result of or arising from the use of any online 
link available between the Software and another server including without limitation in connection with Online Services.

(a)	 Third Party On-line services:  Except as required by the Consumer Guarantees, Reckon makes no warranty or representation in connection with 
the Third Party Online Services, the responsibility for which rests with the relevant provider of such Third Party Online Services or such hardware.

10. TERM AND TERMINATION OF LICENCE

(a)	 Licence Term: Unless this Licence is terminated earlier in accordance with its terms, your right to use the Software in accordance with this Licence 
continues:

(i)	 in the case of a subscription version of the Software, for an initial period of 12 months from the date of registration of the Software.  This 
Licence will automatically renew for a further 12 month period upon the payment of Reckon’s annual subscription fee.  If the annual 
subscription fee is not paid on or before the termination of the current 12 month period, this Licence will automatically terminate; and

(ii)	 in the full version of the Software, indefinitely, however:
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(A)	 you may be required to periodically verify your licence details and have the Software reactivated as per clause 3 in order to keep using 
the Software; and

(B)	 if you need to reinstall the Software, you will need a copy of your original CD (or other media on which the Software was provided) 
and the installation key code.  If you do not have the CD, you will need to purchase or upgrade to a new full version and pay for the 
postage associated with sending the CD to you. Clauses 4(d) and 4(g) outline when Reckon may charge you a fee for the provision of 
a replacement key code and, more importantly, when a replacement key code will not be provided by Reckon due to the operation of 
Reckon’s sunset policy.

(b)	 Termination by Reckon for breach: Reckon may terminate this Licence if you are in breach of its terms or as otherwise set out in this Licence.

(c)	 Survival: Clauses 2, 6, 8, 9 and this clause 10 will survive the termination of this Licence. Termination of this Licence will not prejudice any right 
which Reckon may have, or but for the termination may have had, against you for a breach of this Licence.

(d)	 Things you must do on termination: Upon the termination of this Licence, you or your representative must promptly uninstall the Software from 
your computer, destroy the CD, User Guide and related materials and any copies of them in your possession or control or return or dispose of 
them in the manner directed by Reckon.  Upon written request from Reckon you agree to provide a Statutory Declaration to Reckon that you 
have complied with your obligations under this clause 10(d).

11. SUBSCRIPTION TERMS

If you have purchased a subscription version of the Software, this additional clause 11 will apply.

(a)	 Entitlement to Upgrades and Updates: During the period for which you have paid subscription fees you will receive, included in the cost of the 
subscription, all Upgrades and/or Updates of the Software, via Internet download. 

(b)	 No extension of Licence term: Your right and entitlement to use the Software, as enhanced by any Upgrades and/or Updates, concludes at the end 
of the term of the Licence (subject to payment of an annual subscription fee) and is not linked to the dates of release, registration or provision by 
Reckon of any Upgrades and/or Updates.

(c)	 This Licence prevails: If you have purchased this Software as an Upgrade to an earlier version of the Software, this Licence shall supersede any 
previous licence agreement. 

(d)	 Not all Upgrades included: Your subscription to the Software and any Upgrades and/or Updates under this Licence does not grant you the right 
to receive special versions of the Software created for certain customers or market segments, even though they may contain similar features 
or functions.  Versions of the Software which may from time to time be offered in retail or other channels in different configurations as special 
promotions are not included as part of the subscription. 

(e)	 No obligation on Reckon to upgrade: Upgrades and/or Updates will be developed and released by Reckon in its sole discretion, and Reckon does 
not warrant or represent that it will develop or release any Upgrades and/or Updates during the term of the subscription period or Licence.  
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Furthermore, Reckon does not warrant that the Upgrades and/or Updates will be provided to you or made available within any specified time 
period following the commercial release of such Upgrades and/or Updates. 

(f )	 When payment is due: If applicable to the Software licensed to you, you will be required to pay the monthly subscription fee in advance on the 
first business day of each month.  You authorise Reckon to direct debit your monthly subscription fee from the bank account nominated by you. 

(g)	 Deactivation at end of subscription period: As per clause 4, the subscription version of the Software is provided to you on the understanding and 
acknowledgment that it may contain technology which deactivates and disables the software if your subscription is not renewed or you are 
found to be in breach of this licence agreement.  If the Software is not renewed by the end of the required period, the Software may continue to 
operate but with impaired functionality or you may not be able to access the Software at all (including printing out or viewing any of your data or 
records).

(h)	 You need a full version if you don’t renew: If you elect not to renew your subscription, the Software does not allow you to upgrade to a non-
subscription version of the Software by way of the purchase of an Upgrade pack.  In such circumstances, you are only able to upgrade to a later 
non-subscription version of the Software by purchasing a full (non-upgrade) version of the Software.

(i)	 Early termination: If you wish to terminate your subscription early, you must do so by giving Reckon no less than one calendar month notice to 
that effect.  Depending on the type of software you have subscribed to and the type of subscription you are signed up for, you may be required 
to pay a cancellation fee.  See http://www.reckon.com.for a schedule of fees.  Reckon will direct debit your account, and you agree to pay, the 
applicable cancellation fee.

12. TRIAL LICENCE

If you have been provided with a Trial Version of the Software, this clause 12 sets out the terms that will apply to your use of the Trial Version.

(a)	 Licence: Your licence to use the Trial Version:

(i)	 permits you to evaluate the Software’s functionality and suitability for your requirements;

(ii)	 is for the number of users set out in the material accompanying your copy of the Trial Version;

(iii)	 is subject to the general restrictions in clause 2 and the limited warranty in clause 7,

(iv)	 is for one month (Evaluation Period)

(b)	 Duration: You acknowledge that your licence to use the Trial Version will only apply for the Evaluation Period. At the end of the Evaluation Period:

(i)	 you must not and will not be able to continue to access the Trial Version, including any data that you have entered into the Trial Version; and

(ii)	 if you wish to use the Software you must purchase a full version or subscription version of the Software.

(c)	 Entitlements: You:

(i)	 are not entitled to Upgrades or Updates (or any other software other than the Trial Version); and
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(ii)	 may be required to pay for any technical support that you may require in relation to the Trial Version in accordance with Reckon’s then 
current charges.

(d)	 Liability: You acknowledge that subject to clauses 9(b) and 9(c), and to the full extent permitted by law, Reckon excludes all liability to you for any 
loss, damage, liability, costs or expenses suffered by you relating to the performance or non-performance of the Trial Version or any breach of this 
clause 10.

13. STUDENT EDITION

(a)	 If you are using a Student Edition, your Software may have limited licence rights and well as limited functionality, including:

(i)	 a limit on the number of transactions that can be entered;

(ii)	 a limit on the number of company files that can be opened;

(iii)	 a limit on the number of Software features and services available;

(b)	 Your Software may be deactivated at the end of three years from date of installation and this may prevent access to the Software and data unless 
an appropriate upgrade is purchased.

(c)	 There is no support available for Student Edition.  Support requests must be directed to your educational institution.

(d)	 Except as required by the Consumer Guarantees, Reckon does not warrant that any information in the Software is up to date, for example 
functionality required for certain lessons involving tax tables or payroll tax, and it is your sole responsibility to check with your educational 
institution whether any information is up to date.

14. GENERAL

(a)	 Some defined terms: In this Licence:

Trial Version means Software that has been provided to you on a temporary basis in order to carry out a trial of that Software to determine 
whether you wish to use the Software on an ongoing basis.

Student Version means Software that is licensed to you as part of your educational institution’s arrangement with Reckon or Software that you 
have purchased that Reckon has determined is a Student Version.

Upgrade means a new version of the Software which contains additional functionality or other enhancements.   Reckon will determine whether a 
new version constitutes an Upgrade or an Update.

Update means a new version of the Software which contains minor enhancements.

(b)	 Applicable law: This Licence is governed by the laws of the State of New South Wales, Australia and by agreeing to be bound by the terms of this 
Agreement you irrevocably and unconditionally submit to the jurisdiction of the courts of that State. 
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(c)	 Consumer Guarantees: Is the consumer guarantees regime as set out in Schedule 2 to the Competition and Consumer Act 2010 (Cth) (also 
referred to as the Australian Consumer Law), or the Consumer Guarantees Act 1993 (NZ), as amended from time to time, or other similar 
legislation of a state or territory of Australia or NZ respectively.

(d)	 Entire Agreement: This Licence contains the entire agreement between Reckon and you in relation to its subject matter and supersedes any prior 
agreements and understandings, whether written or oral.

(e)	 Evaluation Fee: The fee set out on the pricing page of the Website at the relevant time to obtain an Evaluation Licence to use the Services on trial.

(f )	 Headings: Clause headings are for ease of reference only and do not affect the meaning of this Licence.

(g)	 Privacy Laws: Privacy Act 1988 (Cth) and the Australian Privacy Principles (“the Privacy Principles”), as amended from time to time

(h)	 Third Party Applications and Technology: When using the Services, you may access third party applications and technology. The terms of the third 
party’s Licence will apply to your use of all such third party applications and technology. 

(i)	 Variation: To the extent permitted by law, Reckon may vary any of the terms and conditions of this Licence upon providing you with thirty (30) 
days notice in writing and a copy of the replacement terms and conditions. No new terms will come into force until the commencement of your 
renewed Subscription Period. Reckon will display any new terms and conditions on the Website and you should check the website regularly.

(j)	 Waiver: Any failure to enforce any rights under this Licence by Reckon is not to be taken as a waiver of those rights.

(k)	 Reckon’s Contact details: 	

business address: Level 12, 65 Berry Street, North Sydney, NSW 2060

postal address: Reckon Limited, Locked Bag 7522, McMahons Point, NSW, 2060

contact number: 1800 RECKON (Toll-free 1800 732 566)

contact email: customerservice@reckon.com

Reckon, Reckon logo, Reckon Accounts and R logos are trademarks of Reckon Limited.
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